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Introduction 1 

1 Introduction 

This manual describes the exchange of Building Information Modeling (BIM) data between Revit 
2021 and ETABS v18 or greater, SAP2000 v20 or greater, and SAFE 2016 or later. 

Data can be repeatedly exchanged between Revit and ETABS, between Revit and SAP2000, and 
between Revit and SAFE along the following paths: 

• Exporting from a Revit project to create a new ETABS, SAP2000, or SAFE model. 

• Exporting from a Revit project to update a previously exported or previously imported 
ETABS, SAP2000, or SAFE model. 

• Importing from an ETABS, SAP2000, or SAFE model to create a new Revit project. 

• Importing from an ETABS, SAP2000, or SAFE model to update a previously imported or 
previously exported Revit project. In this case, you may choose to update locations, designs, 
or both. 
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The flow of data in these exchanges is illustrated below: 

           
 

                                                                            
 

The remainder of this manual is organized in three chapters: 

• Chapter 2 presents the exchange of data between Revit and ETABS.  

• Chapter 3 presents the exchange of data between Revit and SAP2000. 

• Chapter 4 presents the exchange of data between Revit and SAFE. 

 

Revit® 

Export from Revit to create a new ETABS, SAP2000 or SAFE model, or 

update an existing one. 

           

Import from ETABS, SAP2000 or SAFE to create a new Revit 

project or update an existing Revit project. 

         

   

ETABS®, SAP2000® or 
SAFE® 
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2 Revit and ETABS Data Exchange 

Data can be exchanged between Revit and ETABS along the following paths: 

• Exporting from a Revit project to create a new ETABS model. 

• Exporting from a Revit project to update a previously imported or previously exported ETABS 
model. 

• Importing from an ETABS model to create a new Revit project. 

• Importing from an ETABS model to update a previously exported or previously imported 
Revit project. 

The actual data transferred varies in each of these cases. 

2.1 Data Exported from Revit when Creating a New ETABS model 

The table below provides an overview of the data imported into ETABS when exporting from a 
Revit project to create a new ETABS model: 

Action Project Element Supported Notes 

Creation of…       

 Grid Lines    

 Story Levels   

 Materials    

 Structural Columns and 
Structural Framing 

  Transfers geometry, offsets, end releases, and 
beam and brace y and z justifications into 
ETABS. Imports columns based on splice 
information in ETABS. 
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 Steel Column and 
Framing Family Section 
Geometry 

  Creates and maps equivalent ETABS frame 
sections. Makes Auto-Select Lists in ETABS 
for all families used in the Revit project. 

 Concrete Column and 
Framing Family Types 

  Creates and maps equivalent ETABS frame 
sections. 

 Walls   Slanted or warped walls not imported. Slanted 
walls do not have an analytical model in Revit. 

 Wall Section Geometry   Creates and maps equivalent ETABS wall 
sections. 

 Wall Openings   

 Floors   Sloped floors with more than four outer corners 
are projected on a horizontal plane. 

 Floor Section Geometry   Creates and maps equivalent ETABS slab and 
deck sections. 

 Floor Openings   

 Footings   Creates fixed joint restraints in ETABS 
wherever a footing occurs in Revit.  

 Point Loads    

 Line Loads    

 Area Loads   Non-uniform area loads not imported. 

 Load Cases   Creates both an ETABS load pattern and load 
case for each Revit load case.  

 Load Combos    

 

2.1.1 Grid Lines 

The following Revit grid line attributes are imported in ETABS: 

• Grid Line Name: The same grid name is used in the ETABS grid bubble. 

• Grid Line Points: The start and end points are used to define the general grid line in ETABS. 

• Curved Grid Line: The center point, radius, start angle and aperture are used to define the 
circular grid line in ETABS.  
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2.1.2  Story Levels 

The following Revit material attributes are imported in ETABS: 

• Level Name: The same name is used in ETABS. 

• Elevation: The elevation retrieved relative to the project origin is the elevation of the imported 
story level. 

2.1.3 Materials 

The following Revit material attributes are imported in ETABS: 

• Material Name: The same name is used in ETABS. 

• Material Type: The Revit material type is used to identify the ETABS material type, namely 
Concrete, Steel or Other. 

• Young’s Modulus: The Young’s modulus values from Revit set the ETABS material Young’s 
modulus (E). These three values (for the three different directions) cannot be zero in ETABS. 
If the first value is zero, then the default ETABS value is used. If any of the remaining two are 
zero, then the first non-zero value is used. For an isotropic material, the first value is used for 
all other directions. 

• Poisson’s Ratio: Poisson’s Ratio values from Revit set the ETABS material Poisson’s Ratio 
(u). These three values (for the three different directions) cannot be zero in ETABS. If the first 
value is zero, then the default ETABS value is used. If any of the remaining two are zero, then 
the first non-zero value is used. For an isotropic material, the first value is used for all other 
directions. 

• Shear Modulus: Shear Modulus value from Revit set the ETABS material Shear Modulus (G). 
If the Revit material is defined as isotropic, then ETABS calculates this value on the basis of 
the Young’s Modulus and the Poisson’s Ratio. In the case of an orthotropic material, these 
three values (for the three different directions) cannot be zero in ETABS. If the first value is 
zero, then the default ETABS value is used. If any of the remaining two are zero, then the first 
non-zero value is used.  

• Thermal Expansion Coefficient: The thermal expansion coefficient from Revit sets the 
ETABS material thermal expansion coefficient (Alpha). These three values (for the three 
different directions) cannot be zero in ETABS. If the first value is zero, then the default 
ETABS value is used. If any of the remaining two values are zero, then the first non-zero value 
is used. For an isotropic material, the first value is used for all other directions. 

• Weight Density and Mass Density: The unit weight value from Revit sets the ETABS material 
weight density (w) and mass density (m). In ETABS, the mass density is calculated by dividing 
the weight density by the gravitational constant (g). The weight density cannot be zero in 
ETABS. If the unit weight is zero in Revit, then the default ETABS densities are used.  



CSiXRevit 2021 Revit and ETABS Data Exchange 

Revit and ETABS Data Exchange 6 

• Damping Ratio: This value is not in used in the current version of ETABS. 

• Bending Reinforcement: The bending reinforcement value from Revit sets the ETABS 
material main reinforcement Fy if the type is concrete. If this value is zero in Revit, then the 
default ETABS value is used. 

• Shear Reinforcement: The shear reinforcement value from Revit sets the ETABS material 
shear reinforcement Fy if the type is concrete. If this value is zero in Revit, then the default 
ETABS value is used. 

• Resistance Calculation Strength: The resistance calculation strength from Revit sets the 
ETABS material f’c factor. If this value is zero in Revit, then the default ETABS value is used. 

• Behavior: The Revit behavior tag is used to identify the isotropic or orthotropic materials in 
ETABS. 

• Concrete Compression: The concrete compression value from Revit sets the ETABS material 
f’c if the type is concrete. 

• Lightweight: The Revit lightweight tag is used to identify the lightweight concrete material in 
ETABS. 

• Shear Strength Reduction: This value is not in used in the current version of ETABS. 

• Yield Stress: The yield stress value from Revit sets the ETABS material yielding stress Fy if 
the type is steel. If this value is zero in Revit, then the default ETABS value is used. 

• Tensile Strength: The tensile stress value from Revit sets the ETABS material ultimate stress 
Fu if the type is steel. If this value is zero in Revit, then the default ETABS value is used. 

• Steel Reduction Factor: This value is not in used in the current version of ETABS. 

Only those materials assigned to floor, wall, or frame elements in the Revit project are imported into 
ETABS. 

ETABS writes a warning in the .wrn file it writes when a default value is used while importing 
materials from the Revit project. 

2.1.4 Structural Column and Framing Elements 

The following Revit structural column and framing element attributes are imported into ETABS: 

• End Points: For straight column and framing elements and curved framing elements other than 
arc shaped, the coordinates of the end points of the lines defining the analytical model of the 
element are retrieved and ETABS point objects with identical coordinates are created. When 
the analytical model of an element includes rigid links, the ETABS joint objects are created at 
the ends of the rigid links with ETABS joints offsets created to model the link. For arc shaped 
framing elements, the coordinates of the end points of the elements themselves are imported 
instead of the end points of their analytical models because these analytical models consist of 
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series of short straight segments and such a tessellation is not required in ETABS 2013 and 
later. Columns are imported with the Local Axis 1 always pointing up, and beams and braces 
with their Local Axis 1 always in the first quadrant, which means that the end joints may have 
been switched compared to the Revit end points. Multi-story columns and braces are 
automatically broken into several single story ETABS frame objects. This is required for 
reporting and design. 

• Curvature: Straight elements are imported as straight ETABS frame objects. Curved framing 
elements that are not arc shaped are imported as series of short ETABS objects based on the 
lines defining their analytical models. Arc shaped framing elements are imported as arc shaped 
ETABS line objects.  

• Family Types: The family type assigned to the Revit element is imported along with the whole 
family. ETABS converts the Revit family to an ETABS auto selection list.  

• End Releases: End releases defined in the element analytical models are imported into 
ETABS. ETABS restricts releases that would cause an analytical instability, such as for 
example torsion released at both ends. When that happens, ETABS writes a warning in the 
.wrn file it writes. When ETABS joints have been switched compared to Revit end points, end 
releases are also switched. 

• Insertion Points: In Revit, the beam or brace insertion point is defined by the following two 
parameters: 

o Z-Direction Justification 

o Lateral Justification 

ETABS calculates the corresponding insertion point based on these two parameters. If these 
parameters are not defined then the default cardinal point, Top Center, is chosen. Columns in 
Revit have no parameters corresponding to the ETABS insertion point and they are imported 
with a Middle Center insertion point. 

• Rigid Links: When the analytical model of an element includes rigid links, these are imported 
as end offsets. You can visualize them by looking at the ETABS model in extruded view. In 
addition, when a beam has its z-Direction Justification parameter set to Other, an additional 
vertical offset is created at both ends of the ETABS frame object based on the value of the z-
Direction Offset parameter. Other beam offset parameters such as Start Level Offset and End 
Level Offset are not taken into consideration because, except for arc shaped members, end 
joints are located based on the end points of the analytical model which already reflects the 
values of these parameters. When ETABS joints have been switched compared to Revit end 
points, end offsets are also switched. 

• Orientation Angles: The ETABS Local Axis 2 Angle of columns is computed based on their 
rotation as internally stored in Revit. The ETABS Local Axis 2 Angle of beams and braces is 
computed based on the value of their Cross-Section Rotation parameter. When ETABS joints 
have been switched compared to Revit end points, rotations are adjusted accordingly.  
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2.1.5 Structural Column and Framing Element Sections 

This section explains how ETABS maps the sections specified by various Revit family types of 
structural columns or framing elements to ETABS frame sections. 

• If the ETABS model into which the Revit project is being imported already contains an 
ETABS frame section with the same name as a Revit family type, the Revit structural column 
or framing elements with that family type are imported with that ETABS section. The name 
comparison is not case-sensitive, and the prefixes UB and UC are considered equivalent to, 
respectively, UKB and UKC. Note that if you import a Revit project into ETABS, and later 
redefine a given Revit family type and then re-import the Revit project, ETABS will not 
redefine the ETABS frame section. 

• If the ETABS model does not contain any frame section with the same name as a Revit family 
type, but does contain a frame section whose name matches part of the name of a Revit family 
type, the Revit structural column or framing elements with that family type are imported with 
that ETABS section. 

• If a Revit family type is an instance of one of the pre-defined concrete or wood structural 
column or structural framing families listed in Table 1, or the steel plate or steel round bar 
families, ETABS creates a frame section with the same name, shape, and dimensions as the 
family type and the Revit structural column or framing elements with that family type are 
imported with that ETABS section. 

• If the above did not apply, ETABS looks for a frame section with the same name as the Revit 
family type in its .xml catalogs of section properties. If it can find a namesake frame section, 
it loads it into the ETABS model, and the Revit structural column or framing elements with 
that family type are imported with the namesake ETABS section. You can interactively add 
or remove .xml catalogs and you can change their search order when you import the Revit 
project into ETABS. 

• If ETABS cannot find any frame section with the same name as a Revit family type in its .xml 
catalogs, but does find a frame section whose name matches part of the name of a Revit family 
type, it loads it into the ETABS model, and the Revit structural column or framing elements 
with that family type are imported with the ETABS section with the abbreviated name. 
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Figure 1: Import of Sections from Catalog (.xml) files 

 

 

Figure 2: Adding and removing Catalog files when importing into ETABS 

• If none of the above applied, the Revit structural column or framing elements with the 
unrecognized family type are assigned a default ETABS section. You can specify any ETABS 
section already in the model as a replacement, or you can explicitly define a new ETABS 
section and specify it as a replacement, or you can load a section from any of the ETABS .xml 
catalog, and specify it as a replacement. 

You can save the ETABS frame section assignments you have made to a mapping file, and ETABS 
will reuse these assignments on subsequent imports. 
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Member Type Family Name Parameters 

CONCRETE 
COLUMNS 

CONCRETE-RECTANGULAR-
COLUMN 

B, H 

 CONCRETE-ROUND-COLUMN B 

 CONCRETE-SQUARE-
COLUMN 

B 

 PRECAST-RECTANGULAR 
COLUMN 

B, H CHAMFER 

CONCRETE 
FRAMING 

PRECAST-DOUBLE TEE WIDTH, TEE WIDTH, 
STEM WIDTH, SLAB 
DEPTH, DEPTH 

 PRECAST-INVERTED TEE H1, H, B, SEAT 

 PRECAST-L SHAPED BEAM H1, H, B, SEAT 

 
CONCRETE-RECTANGULAR 
BEAM, PRECAST-
RECTANGULAR BEAM 

B, H 

 PRECAST-SINGLE TEE WIDTH, STEM WIDTH, 
SLAB DEPTH, DEPTH 

WOOD COLUMNS DIMENSION LUMBER-
COLUMN 

B, D, SY, SX, IY, IX, A 

 GLULAM-SOUTHERN PINE-
COLUMN 

B, D, SY, SX, IY, IX, A 

 GLULAM-WESTERN SPECIES-
COLUMN 

B, D, SY, SX, IY, IX, A 

 PSL-PARALLEL STRAND 
LUMBER-COLUMN 

B, D, SY, SX, IY, IX, A 

 TIMBER-COLUMN B, D, SY, SX, IY, IX, A 

WOOD FRAMING DIMENSION LUMBER B, D, SY, SX, IY, IX, A 

 GLULAM-SOUTHERN PINE B, D, SY, SX, IY, IX, A 

 GLULAM-WESTERN SPECIES B, D, SY, SX, IY, IX, A 

 LVL-LAMINATED VENEER 
LUMBER 

B, D, SY, SX, IY, IX, A 

 TIMBER B, D, SY, SX, IY, IX, A 

 OPEN WEB JOIST B, H 

 PLYWOOD WEB JOIST B, H 
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STEEL 

FRAMING 

PLATE B, D 

ROUND BAR D 

Table 1: Revit Family Names recognized by ETABS and associated Parameter Tags 
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2.1.6 In-place Family Members 

Revit in-place family members are not imported into ETABS. 

2.1.7 Walls 

The following wall attributes are imported into ETABS: 

• Points: The coordinate of all the points in the wall analytical model are retrieved and ETABS 
joint objects with identical coordinates are created. Revit walls may be defined as having more 
than four corners, but ETABS walls can only have three or four. Revit walls with more than 
four corners are broken into several four corner ETABS walls, with a few three corner walls 
when some of the edges are sloped. Also, multi-story walls are broken into several single story 
ETABS walls. This is required for analysis results reporting and concrete reinforcement 
design. 

• Wall Curve: Arc shaped curved walls with horizontal bases and tops are imported as ETABS 
curved walls. Straight wall edges are imported as such. Other edges are tessellated, with the 
degree of approximation defined internally by Revit, and the wall is imported as a series of 
walls. Note that when a Revit wall is arc shaped in plane but its top is not horizontal, its top 
curve is not an arc and will be tessellated. 

• Wall Openings: Wall openings are imported based on their locations. Opening with more than 
four sides are broken into three and four node openings. Multi-story openings are broken into 
several single story openings. 

• Wall Thickness: A Revit wall has different layers, each having different thickness and material 
properties. ETABS only considers the layer with the maximum thickness when importing the 
data from Revit.  

• Wall Materials: All the materials assigned to the different layers of a Revit wall are imported 
into ETABS. However, only one material is assigned to the ETABS wall section property. The 
material of the wall layer with the maximum thickness is used.  

Slanted or warped walls, with their top not lined up with the base when looked at from above, are 
not imported into ETABS. Slanted walls do not have an analytical model in Revit. 

2.1.8 Floors 

The following floor attributes are imported into ETABS: 

• Points: The coordinate of all points in the floor analytical model are retrieved and ETABS 
joint objects with identical coordinates are created. 

• Floor Edge Curvature: Arc-shaped floor element edges are imported as arc-shaped floor edges 
in ETABS. Straight floor edges are imported as such. All other curved floor edges are 
tessellated, with the degree of approximation defined internally by Revit. Floors with more 
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than four outer corners are projected onto a horizontal plane at an elevation matching their 
average elevation. 

• Number of Layers: Revit floor family types consist of one or several layers. ETABS reads the 
layer information and imports the floor element with a slab section if its floor type includes a 
single layer, and with a filled deck section otherwise. 

• Layer Thickness: The overall thickness of the ETABS deck or slab section assigned to an 
imported floor element is the thickness of the thickest layer in the Revit floor family type. 

• Material: The material of the thickest layer is assigned to the ETABS deck or slab section. A 
default material is used if no material is defined in Revit. 

• Deck Profile: If the Revit floor family type assigned to the floor element references a deck 
profile family type, ETABS interprets the parameters of the deck profile type as follows:  

o The parameter labeled “HR” measures the deck depth 

o The parameter “SR” measures the deck rib spacing 

o The parameter “WR” measures the width of the top of the deck ribs 

o The parameter “RR” measures the width of the bottom of the deck ribs 

o The parameter “THICKNESS” measures the thickness of the metal 

Note that the composite shear stud diameter is taken as equal to the bottom rib width, and 
its height, and its height is taken as the overall section depth minus the thickness of the 
metal. 

• Floor Span Directions: The Revit span direction is imported for decks. A default direction is 
used if no span direction is defined in Revit.  

• Floor Openings (Regular or Irregular): Openings defined in Revit by “Modeling>Opening> 
Vertical Opening” are imported into ETABS. 

• Ramps: All inclined slabs with three or four sides are imported as floor objects in ETABS.  

2.1.9 Openings 

The following opening attributes are imported into ETABS: 

• Horizontal Openings: These are imported as openings in the floors. 

• Wall Openings: These are imported as openings in the walls (vertical planes).  

• Shaft Openings: In Revit, a shaft opening element is defined as a vertical extrusion with upper 
and lower limits (or offset elevations from upper and lower story levels). In ETABS the shaft 
opening is imported as horizontal floor openings at all the story levels that lie between the 
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upper and lower limits of the 3D shaft. 

2.1.10 Footings 

The following footing attributes are imported into ETABS: 

• Width, Length: For rectangular footings, the width, length and thickness are imported. In this 
case, ETABS locates all the columns within the rectangular footing area and restrains them. 

Only rectangular footings are processed. 

2.1.11  Point Loads 

The following point load attributes are imported into ETABS: 

• Load Case Name: It sets the corresponding load case name in ETABS. 

• Location: It is used to define the point of application of the load. 

• Fx, Fy, Fz, Mx, My, Mz: All forces and moments applied in the global direction, in Revit, are 
transferred in a similar manner into ETABS. 

2.1.12  Line Loads 

The following line load attributes are imported into ETABS from Revit: 

• Load Case Name: It sets the corresponding load case name in ETABS. 

• Start and End Point Locations: Used to define the start and end point of the line load. Line 
loads carrying the gravitational load and overlapping more than one beam are distributed to 
the corresponding beams in ETABS. In the case of a lateral line load, users must check no line 
load overlaps more than one beam; otherwise it is not processed in the ETABS analysis. 

• Fx, Fy, Fz, Mx, My, Mz: All forces and moments applied in the global direction, in Revit, are 
transferred in a similar manner into ETABS. A Revit line load which includes more than one 
of these components is imported as several ETABS line loads because ETABS line loads are 
mono-directional. 

2.1.13  Area Loads 

The following area load attributes are imported into ETABS from Revit: 

• Load Case Name: It sets the corresponding load case name in ETABS. 

• Points: Points are used to define the geometry of the loading area. Curved edges that are arc 
shaped are imported as arcs. Straight edges are imported as such. Other edges are tessellated, 
with the degree of approximation defined internally by Revit. 
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• LoadX, LoadY, and LoadZ: All loads applied in the global direction in Revit are transferred 
in a similar manner into ETABS.  

Non-uniform surface loads are not imported into ETABS.  

2.1.14  Load Cases 

The following load case attributes are imported into ETABS: 

• Load Case Name: The same name is used for the ETABS load case. 

• Load Case Category: It is used to define the load case type in ETABS. The mapping is shown 
in the following table: 

Revit Load Case Category ETABS Load Case Type 

Dead Dead 

Live Live 

Wind Wind 

Snow Snow 

Roof Live Live 

Accidental Other 

Temperature Other 

Seismic Quake 

2.1.15  Load Combos 

The following load combination attributes are imported into ETABS: 

• Load Combination Name: The same name is used for the ETABS Load Combination Name.  

• Load Cases: The same load cases list is used in ETABS to define the Load Combination. 

• Load Case Factor: The same load case factors are used for the corresponding load cases in the 
ETABS load combination. 

2.1.16  ETABS Auto Select Lists 

ETABS automatically creates Auto-select lists based on the Revit family types that are loaded in the 
current Revit project and being exported into ETABS. 
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2.2 Data Exported from Revit when Updating an ETABS model 

The table below provides an overview of the data imported in ETABS when exporting from Revit 
to update an existing ETABS model: 

Action Model Element Supported Notes 

Creation of…    

 Grids   
 

 Story Levels  
 

 Materials   Creates equivalent ETABS materials.  

 

Frames   Transfers geometry, offsets, end releases, and 
beam and brace y and z justifications, into 
ETABS. Cuts all columns at story levels. 

 Frame Sections    

 Steel Sections   Maps to ETABS database sections. 

 Concrete Sections   Creates and maps equivalent ETABS sections. 

 Walls    

 
Wall Properties    

 Wall Openings   

 Floors    

 
Slabs Properties    

 
Deck Properties    

 Floor Openings   

 
Footings   Creates fixed joint restraints in ETABS 

wherever a footing occurs in Revit. 

 Joint Loads    

 Frame Loads    

 Shell Loads    

 Load Cases    

 Load Combos    

Update of…      

 Grids   
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 Story Levels   

 Materials X  

 
Frames 

X  

 Frame Sections X  

 Steel Sections X  

 Concrete Sections X  

 
Walls 

X 
Walls with changing number of sides are 
replaced. 

 Wall Properties X  

 
Wall Openings 

 
Wall openings with changing number of sides 
are replaced. 

 Floors X  

 Slabs Properties X  

 Deck Properties X  

 
Floor Openings 

 
Floor openings with changing number of sides 
are replaced. 

 Point Loads X  

 Line Loads X  

 Area Loads X  

 Load Cases X  

 Load Combos    

Deletion of…      

 Grids    

 Story Levels   

 Frames    

 Walls    

 Wall Openings   

 Floors    
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 Floor Openings   

 Footings   

 Point Loads    

 Line Loads    

 Area Loads    

 Load Cases    

 Load Combos    
 

Note: Deletion of ETABS objects when updating a model only works if you are exporting the entire 
Revit project. If the “selection only” update feature is used, no ETABS objects are deleted. 
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2.3 Data Imported from ETABS when Creating a New Revit Project 

The table below provides an overview of the data imported into Revit when creating a new Revit 
project: 

Action Model Element Supported Notes 

Creation of…    

 Grids    

 Story Levels   

 

Materials 

  

Imports Concrete and Steel materials into Revit 
from ETABS. Limitation is the Revit project 
should have one default concrete and one 
default steel material for duplication, otherwise 
the material will be created in Revit but its 
parameters will not be updated, and the 
properties of the new materials are identical to 
those of the template materials. 

 
Columns, Beams, 
Braces   

Imports steel columns based on splice locations 
in ETABS. 

 

Frame Sections 

  

Column cardinal points are not exported to 
Revit because the concept is not supported in 
Revit. 

 
Steel Sections 

   

 

Concrete Sections 

  

Creates and maps equivalent Revit sections.  

See Frame Sections below. 

 

Walls 

  

Non-rectangular slanted walls and warped 
walls not imported. Rectangular slanted walls 
with a horizontal base imported, but without an 
analytical model as this is not available for such 
walls in Revit. 

 Wall Properties    

 Wall Openings   

 Floors    

 Slabs Properties    

 Deck Properties   

 Footings    

 Load Cases   
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 Joint Loads    

 
Frame object Loads 

  
Creates equivalent Revit point line loads and 
trapezoidal line loads. 

 

Concrete Beam 
Reinforcement 

 

Creates equivalent Revit Concrete Beam 
Reinforcement if ETABS exr file has been 
updated in CSiDetail. 

 

Concrete Column 
Reinforcement 

 

Creates equivalent Revit Concrete Column 
Reinforcement if ETABS exr file has been 
updated in CSiDetail. 

 

Concrete Slab 
Reinforcement 

 

Creates equivalent Revit Concrete Slab 
Reinforcement if ETABS exr file has been 
updated in CSiDetail. 

 

Concrete Wall 
Reinforcement 

 

Creates equivalent Revit Concrete Wall 
Reinforcement if ETABS exr file has been 
updated in CSiDetail. 

 Shell Member Loads   Creates equivalent Revit area loads. 

 Load Combos    

 

2.3.1 Frame Sections 

This section explains how CSiXRevit maps ETABS frame sections to Revit structural column and 
framing element family types: 

• If the Revit project into which the ETABS model is being imported already contains a Revit 
family type with the same name as an ETABS frame section, the ETABS columns, beams and 
braces with that frame section are imported with that Revit family type. The name comparison 
is not case-sensitive. Note that if you import an ETABS model into Revit, and later redefine a 
given ETABS frame section and then re-import the ETABS model, CSiXRevit will not 
redefine the corresponding Revit family type. 

• If the type of the frame section is one of the section shape types listed in Table 2 or Table 3, 
CSiXRevit creates a new type of the corresponding Revit family in the Revit project based on 
the original ETABS section dimensions, and the ETABS columns, beams and braces with that 
frame section are imported with that Revit family type. 

• If the above did not apply, CSiXRevit looks for a pre-defined family type with a matching 
name in the active Revit content libraries, and if it finds one, loads that family type in the Revit 
project and the ETABS columns, beams and braces with that frame section are imported with 
that Revit family type.   

• If the above still did not work, CSiXRevit looks for a pre-defined family type whose name 
includes the name of the frame section in the active Revit content libraries, loads that family 
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type in the Revit project and the ETABS columns, beams and braces with that frame section 
are imported with that Revit family type.   

• If none of the above applied, the ETABS columns, beams and braces are assigned a default 
Revit family type.  You can specify any family type already in the project or any pre-defined 
family type listed in the active Revit content libraries as a replacement. 

Note that you can specify which Revit content libraries are active with the File->Options command, 
under the File Locations tab and Places… button. 

ETABS Section Shape Revit Family 

Concrete rectangular Concrete-Rectangular-Column.rfa, 
M_Concrete-Rectangular-Column.rfa 

Concrete square Concrete-Square-Column.rfa,M_Concrete-Square-Column.rfa 

Concrete circular Concrete-Round-Column.rfa, M_Concrete-Round-Column.rfa 

Table 2: ETABS Column Section Shapes with preset Revit equivalent Families 

ETABS Section Shape Revit Family 

Concrete rectangular Concrete-Rectangular Beam.rfa, 
M_Concrete-Rectangular Beam.rfa 

Concrete angle Precast-L Shaped Beam.rfa, M_Precast-L Shaped Beam.rfa 

Concrete tee Precast-Single Tee.rfa, M_Precast-Single Tee.rfa 

Steel Plate Plate.rfa, M_Plate.rfa 

Steel Rod Round Bar.rfa, M_Round Bar.rfa 

Table 3: ETABS Beam and Brace Section Shapes with preset Revit equivalent Families 
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2.4 Data Exported from ETABS when Updating a Revit Project 

The table below provides an overview of the data imported into Revit when updating an existing 
Revit project: 

Action Model Element Supported Notes 

Creation of…       

 Grids    

 Story Levels   

 Materials    

 Frames   

 Frame Sections    

 Steel Sections    

 

Concrete Sections 

  

Creates and maps equivalent Revit sections.  

See Frame Sections above. 

 Walls    

 Wall Properties    

 Wall Openings   

 Floors    

 Slabs Properties    

 Deck Properties   

 Floor Openings   

 Footings    

 Load Cases   

 Joint Loads    

 Line Loads    

 Area Loads    

 Load Combos    

Update of…       

 Grids    

 Story Levels   

 Materials    

 Frames   Updates changes to column locations only for 
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columns not meshed in ETABS and with a 1:1 
correspondence between Revit and ETABS. You 
can choose between leaving columns meshed in 
ETABS in their original Revit locations or 
replacing them with the ETABS meshed columns. 

 Frame Sections    

 Steel Sections    

 

Concrete Sections 

  

Updates Beam, Column and Brace section 
assignments; however section parameters 
themselves do not update. If you would like to bring 
in the changes to the parameters from ETABS, 
create a new section with the desired parameters in 
ETABS and assign the new section to the frame.  

 

Walls 

  

Updates changes in wall location only for walls not 
meshed in ETABS and with a 1:1 correspondence 
between Revit and ETABS. You can choose 
between leaving walls meshed in ETABS in their 
original Revit locations or replacing them with the 
ETABS meshed walls. 

 

Wall Properties 

  

Updates wall type assignments; however wall types 
themselves do not update. If a wall section is 
changed in ETABS, it is imported under a new 
name in Revit. 

 Wall Openings  Non-rectangular wall openings are not updated. 

 

Floors 

  

Replaces floors which moved, were not meshed 
when brought in from ETABS, and with a 1:1 
correspondence between Revit and ETABS. You 
can choose between leaving floors meshed in 
ETABS in their original Revit locations or 
replacing them with the ETABS meshed floors. 

 
Slabs Properties 

  
Updates floor type assignments; however floor 
types themselves do not update. If a floor section is 
changed in ETABS, it is imported under a new 
name in Revit.  

Deck Properties 
  

 Floor Openings  Floor openings moved in ETABS are replaced. 

 Load Cases   

 Point Loads    

 Line Loads    

 Area Loads   Area loads moved in ETABS are replaced. 
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 Load Combos    

Deletion of…       

 Grids    

 Story Levels   

 Materials   

 Frames    

 Walls    

 Wall Openings  Non-rectangular wall openings are not deleted. 

 Floors    

 
Floor Openings 

  
Floor openings imported as a floor shaft and 
deleted in ETABS are not deleted. 

 Load Cases   

 Point Loads   

 Line Loads    

 Area Loads    

 Load Combos    

 

Note: Deletion of elements when updating a project only works if you are sending the entire model. 
If the “selection only” update feature is used, items are not deleted. 
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2.5 Procedures 

2.5.1 Exporting from Revit to Create/Update a New/Existing ETABS Model 

NOTE: CSiXRevit only exports the analytical models of Revit elements. All the analytical models 
of all the Revit elements must be correctly connected to each other to ensure the stability of the 
ETABS model generated. 

 

Figure 3: Revit Model View 
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Figure 4: Revit Analytical Model View 

The following describes the steps to export a Revit project to ETABS: 

• To create a new ETABS model, from the Revit menu select, Tools>External Tools>Export 
to Create New ETABS SAP2000 or SAFE Model. To update an existing ETABS model, 
from the Revit menu select, Tools>External Tools>Export to Update Existing ETABS or 
SAFE Model. 
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• CSiXRevit counts the elements in the Revit project and displays the Export to Create New 
ETABS SAP2000 or SAFE Model form, or Export to Update Existing ETABS or SAFE 
Model form as may be the case: 

 

• Select the categories of Revit elements to export. If you have selected some elements prior to 
starting the command and wish to only export those elements, check the corresponding box 
near the bottom of the form. 

• To export to ETABS v17 or earlier, check the corresponding box near the bottom of the form. 
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• Once you have made your selections, click OK. The Exporting to Create New ETABS 
SAP2000 or SAFE Model or Exporting to Update Existing ETABS or SAFE model 
information message box is shown and displays the progress of the export: 

 

Once the process is complete, click OK. You are now asked to select a destination folder and 
filename. The file will be given the extension .exr.  

You are now ready to import the .exr file in ETABS: 

• Start ETABS if it is not already running.  

• To create a new ETABS model from your Revit project, you should not have any model open, 
not even an ETABS blank model (an ETABS blank model actually includes four story levels). 
By default, ETABS creates a new model based on your .exr file. To update an existing ETABS 
model, open it. 
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• From the menu, select File>Import>Revit Structure .exr file, and then select the .exr file to 
import. If you are creating a new model, this command is available from the ETABS Start 
Page. 

• 
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The Revit Data Overview/Controls form is displayed: 

 

The top section of this form provides access to more forms which let you specify how Revit 
levels, materials and families are imported in ETABS. 

Any material property with a zero value, any unrecognized section, any section with a default 
material displays a warning. If a material property was not defined, or a material was not 
assigned in Revit, you can address the issue before the ETABS model is created. These issues 
can be addressed by clicking the corresponding Edit button. 

The bottom section of the form displays general controls that ETABS uses when importing 
the Revit project. The units selected here are used as the default units of the ETABS model. 
The length tolerance is the tolerance ETABS uses to align close X, Y, Z coordinates and to 
create connectivity when creating the finite element model for analysis. The Minimum Curve 
Length and Angle let you control how a curve is divided into straight line segments. When 
you check the Align close X, Y or Z Coordinates, ETABS may make small adjustments to the 
original coordinates in the .exr file. Adjustments are then made to the coordinates of grid lines, 
frame objects, and edges of shell objects that are parallel or almost parallel to the horizontal 
plane X or Y axis in the exr file.  These adjustments are two-fold: All imported such items are 
made actually parallel to the X or Y axis as applicable;  and all such items that are almost 
aligned with each other are actually aligned. 
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• To review the various story levels imported from Revit click the Edit button. The ETABS 
Story Data form is displayed, letting you change story heights and other story parameters, and 
add or delete story levels. 

 

• To review the Revit material properties imported, select the Edit button next to “Total 
Materials”. The Material Mapping form is displayed: 

 

In this model, three materials are imported.  Any new ETABS material is created with the 
same name as the Revit material name.  To map the Revit Material to a material other than the 
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new ETABS material created, click on the ETABS material name. A combo box will be 
displayed with all of the existing ETABS materials currently in the ETABS model. To create 
a new material property to map your Revit material to, click Add. The ETABS Add Material 
form is then displayed. To see the properties of any imported material, select the material and 
click Edit. The ETABS Material Property Data form is then displayed: 
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• To check the original properties of the material in Revit, click “Revit Data...” The Revit 
Material Property Data form is displayed: 

 

• To see the Revit family types imported, select the Edit button next to “Total Frame Sections”. 
The Frame Section Mapping form is displayed: 

 

The first three columns display the original Revit family type, original family name, and the 
material assigned to any section imported from Revit. The fourth column is the ETABS section 
the Revit section is mapped to. The final column describes how the section is mapped or 
created. 

Only the ETABS Section Name column is editable. Clicking any row in the column displays 
a combo box that includes all section properties currently loaded in the current ETABS model. 
To add a section to the list, click the Add button the right side. 
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When ETABS imports the Revit data, it initially tries to match Revit section names to ETABS 
section names. It first searches through the loaded ETABS database sections. If no match is 
found, ETABS then searches all the ETABS section property files (.XML). It will map the 
section to the first section name that matches. To specify which files are searched, click the 
.XML Files button on the right side. The XML Property Files form is displayed: 

 

All the .xml property files present in the ETABS installation directory are selected by default. 
A file can be added or removed from the ETABS search by checking or unchecking its 
checkbox in the list. To add a new file, click on the Add File button. To change the order in 
which ETABS searches the files, move their names up and down in the list using the arrow 
key buttons on the right side. 

As in the Material Mapping form, details about the Frame Section Mapping can be edited by 
selecting the row, and clicking the Edit button. 
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• To see the Revit floor sections imported, select the Edit button next to “Total Floor Sections”. 
The Floor Section Mapping form is displayed: 

 

Again, you can specify the ETABS floor section the Revit floor type gets mapped to. By 
default an equivalent ETABS floor section is created and mapped. To create a new deck or 
slab section, use the buttons on the right side. After adding the deck or slab, the new ETABS 
floor section will show up in the drop-down list. 
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• To check the definition of an ETABS section, click on the row and then click the Edit… 
button. The ETABS Slab Property Data or Deck Properties Data form, as applicable, is 
displayed: 
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• To see the Revit wall sections imported, select the Edit button next to “Total Wall Sections”. 
The Wall Section Mapping form is displayed: 

 

Again, you can specify the ETABS wall section the Revit wall type gets mapped to. By default 
an equivalent ETABS wall section is created and mapped. To create a new wall section use 
the Add buttons on the right side. After adding the wall, the new ETABS wall section shows 
up in the drop-down list.  

• To store the mapping created in a file from which it can later be retrieved, click the Export 
Mapping File button in the Revit Data Overview/Controls form. 

• To import a previously exported mapping, click the Import Mapping File button. 

• Once you are satisfied with the mapping of materials and sections, in the Revit Data 
Overview/Controls form select OK. The ETABS model is created. 
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2.5.2 Importing from ETABS to Create/Update a New/Existing Revit Project 

The following steps describe how to export your ETABS analytical model to create or update a Revit 
project: 

• Once you have edited, analyzed and designed the model in ETABS, save it by selecting 
File>Save. 

• Select File>Export>Revit Structure .exr File. 

The Export to Revit .EXR File form is displayed.  

 

• Click the Browse... button to change the destination folder and filename. 

• If you have selected objects in the model, and would like to export only those, select the 
corresponding checkbox. 

• To export to Revit 2019 or earlier, select the corresponding checkbox. 

• Click OK.  

You are now ready to import the .exr file in Revit: 

• Start Revit if it is not already running. 

• To create a new Revit project from your ETABS model, open a Revit template that you would 
like to import your ETABS model into. It is not required, but the import will be faster and 
more predictable if you load all the beam, column, brace, deck, slab and wall families you 
would like ETABS sections to map to prior to importing.   

• From the Revit menu select, Tools>External Tools>Import to Create New Revit Project 
from ETABS, SAP2000 or SAFE.  

• Select the .exr file you would like to import. CSiXRevit will try to load any required families 
that are not already loaded. 

• To update an existing Revit project, first open it. Again, if you have new sections you defined 
in ETABS, the import will come in faster and will be more predictable if you load all the beam, 
column, brace, deck, slab and wall families you would like ETABS sections to map to prior 
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to importing. From the Revit menu select, Tools>External Tools>Import to Update Existing 
Revit Project from ETABS. Select the .exr file to import. 

• Whether you are creating a new Revit project or updating an existing Revit project, after 
selecting the .exr file, the following form is displayed: 

 

On the left side of the form, you can control the types of ETABS objects to import into the 
Revit project and the mapping of ETABS sections to Revit types. 
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• Clicking the Frame Sections button under “Mapping Options” displays the Frame Section 
Mapping form:  

 

Changes to the mapping of ETABS sections to Revit sections can be made here. All Revit 
column beam and brace families and family types currently loaded in the project are displayed 
in the drop-down lists. 
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• Clicking the Floor Sections button displays the Floor Section Mapping form: 

 

Changes to the mapping of ETABS floor sections to Revit sections can be made here. All 
Revit floor families currently loaded are displayed in the drop-down lists. 

• Clicking the Wall Sections button displays the Wall Section Mapping form: 

 

Changes to the mapping of ETABS wall sections to Revit sections can be made here. All Revit 
wall families currently loaded are displayed in the drop-down lists. 
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• If you are updating a Revit project from an ETABS model, you have the choice to only update 
locations and releases, only update designs and load magnitudes, or update both: 

 

• Also, when updating a Revit project from an ETABS model, there can be instances in which 
the 1:1 mapping of Revit elements to ETABS objects is lost because objects were meshed in 
ETABS. If this is the case, you have two options: 

o Delete the existing Revit elements, and let CSiXRevit create new elements corresponding 
to the objects that are meshed in ETABS. 

o Keep the existing elements as they are and use object mapping to control the assignment 
of section properties during the import. 

• If you choose the second option, there may be situations in which you will need to make some 
choices. For example, if a column in Revit runs from the ground floor to the top floor as a 
single element, when imported into ETABS, the column is cut at every floor level. When it is 
designed, different sections might be assigned to each segment of the column. When the 
column (that is now meshed in ETABS) is imported back into Revit, you have the option to 
1) delete the original column in Revit and have CSiXRevit create a column with the varying 
sections or to 2) select one of the frame sections for the entire length of that column. To do 
this, select the corresponding checkbox and click the Objects button under Mapping Options. 
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The Object Mapping form is displayed: 

 

In this case, Column ID (139774) spans three floors in Revit but was meshed into three pieces 
in ETABS. When coming back into Revit, you can choose which section to assign to the entire 
length of the column. The same can be done with meshed beams, braces, floors and walls. 

 

• Once you are satisfied with the object mappings, select OK and the ETABS model will be 
imported. 
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2.5.3 Reviewing the Log File (.log)  

Every time a model is sent from Revit to ETABS or from ETABS to Revit, a file with the extension 
.EXRlog is created if it does not exist, or appended if it already exists. This file lists the project or 
model name, the direction of the data exchange, and the time and date. It also lists any errors or 
omissions encountered in generating or importing the .exr file, and therefore, should be checked 
every time data is transferred. The .EXRlog file also lists the build numbers for CSiXRevit and 
Revit. Finally, in the case of an incremental import, the changes made to the Revit project are listed.  

Each Revit element is identified by its “Revit ID”. You can view the element IDs by selecting 
Manage->Select by ID in the Revit ribbon, typing an ID, and clicking the Show button: 

  

Revit will find a view that contains the element, switch to that view, and highlight the element. 
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2.5.4 Known Limitations of CSiXRevit with ETABS 

• Revit floors that are grouped together may be treated as openings when importing into 
ETABS. 

• Materials imported into Revit from ETABS may not always have their property values 
properly transferred. For this reason, material property values must be carefully checked in 
Revit after importing from ETABS.



 

Revit and SAP2000 Data Exchange 46 

3 Revit and SAP2000 Data Exchange 

Data can be exchanged between Revit and SAP2000 along the following paths: 

• Exporting from a Revit project to create new SAP2000 model. 

• Exporting from a Revit project to update a previously exported or previously imported 
SAP2000 model. SAP2000 v17.2.0 or later is required. 

• Importing from SAP2000 to create a new Revit project. 

• Importing from SAP2000 to update a previously imported or previously exported Revit 
project. In this case, you may choose to update locations, designs, or both. SAP2000 v17.2.0 
or later is required.  

The actual data transferred varies in each case. 

3.1 Exporting from Revit to create a new SAP2000 Model 

The table below provides an overview of the data transferred from Revit to SAP2000: 

Action Project Element Supported Notes 

Creation of…       

 Grid Lines   Does not transfer. 

 Materials    

    Steel   

    Concrete  Does not transfer reinforcement properties. 

    Aluminum  
Imports as isotropic “Other” SAP2000 
material type. 

 

    Generic  

    Other  

    Wood  
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Columns and Framing 
Elements 

  Transfers geometry, beam and brace y and z 
justifications, and end releases into SAP2000. 
Ignores end offsets. 

 
Column and Framing 
Element Sections 

  
 

 

Rolled Steel Sections   Loads equivalent SAP2000 section profiles 
from the SAP2000 .PRO files specified during 
import of the .exr file into SAP2000. 

 Bar Joists  Imports with “None” properties. 

 
Concrete Sections   Creates and maps equivalent SAP2000 

sections. 

 

Walls   Imports walls as SAP000 area objects with wall 
openings imported as separate area objects with 
“None” properties. Imports curved Revit walls 
as a series of short planar SAP2000 area 
objects. Slanted walls and warped walls with 
more than four sides not imported. Slanted 
walls do not have an analytical model in Revit. 

 
Wall Properties   Creates and maps equivalent SAP2000 thick 

shell sections. 

 

Floors   Imports floors as SAP000 area objects with 
floor openings imported as separate area 
objects with “None” properties. 

 
Slabs Properties   Creates and maps equivalent SAP2000 thick 

shell sections. 

 

Slab on Deck Properties   Creates and maps equivalent SAP2000 thick 
shell sections with directional stiffness 
modifiers. 

 
Footings   Does not transfer.  

 

Point Loads   Creates SAP2000 joints if the load does not 
coincide with a previously created joint and 
does not line up with any frame objects. This 
will cause model instability that needs to be 
addressed. 

 

Line Loads   Creates SAP2000 frame objects with “None” 
properties if the load does not overlap any other 
frame object. If the load also does not line up 
with any imported floor or wall, it will cause 
model instability that needs to be addressed.  



CSiXRevit 2021 Revit and SAP2000 Data Exchange 

Revit and SAP2000 Data Exchange 48 

 
Area Loads   Does not transfer. 

 
Load Cases   

 

 
Load Combinations   

 

3.1.1 Grid Lines 

Revit grid lines are not imported in SAP2000. 

3.1.2 Materials 

All Revit materials are imported into SAP2000 as isotropic materials. The following Revit material 
attributes are imported into SAP2000: 

• Material Name: The same name is used in SAP2000. 

• Material Class:  Concrete and steel set to equivalent SAP2000 material types. Generic, 
aluminum, and wood material types set as “Other” SAP2000 material type. 

• Young’s Modulus: The first of Revit’s three Young’s modulus values (one for each direction) 
sets the SAP2000 material Young’s modulus (E) value. If this value is zero, the default 
SAP2000 value is used.  

• Poisson’s Ratio: The first of Revit’s three Poisson’s Ratio values (one for each direction) sets 
the SAP2000 material Poisson’s Ratio (U) value. If this value is zero, the default SAP2000 
value is used.  

• Shear Modulus: The first of Revit’s three Shear Modulus values (one for each direction) is 
compared to the value of the material Shear Modulus (G) computed by SAP2000. If the two 
differ by more than one percent in SAP2000, a warning is reported in the log file. 

• Thermal Expansion Coefficient: The first of Revit’s three thermal expansion coefficients (one 
for each direction) sets the SAP2000 material thermal expansion coefficient (Alpha). If this 
coefficient is zero, the default SAP2000 value is used.  

• Unit weight: The Revit unit weight sets both the SAP2000 material weight density (w) and 
mass density (m). In SAP2000 the mass density is calculated by dividing the weight density 
by the gravitational constant (g). If the unit weight is zero, the default SAP2000 value is used.  

• Behavior: Revit uses this tag to distinguish between isotropic and orthotropic materials. All 
Revit materials are imported as isotropic materials in SAP2000. Any orthotropic material 
generates a warning in the log file. 

• Concrete Compression: In the case of a concrete material, the Revit concrete compression sets 
the SAP2000 concrete compressive strength f’c. 
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• Lightweight: The value of this tag is used to identify a concrete material as lightweight 
concrete in SAP2000. 

• Yield Stress: In the case of a steel material, this value sets the SAP2000 minimum yield stress 
Fy. If the yield stress is zero, the default SAP2000 value is used. 

• Tensile Strength: In the case of a steel material, this value sets the SAP2000 minimum tensile 
stress Fu. If the tensile stress is zero, the default SAP2000 value is used.  

The following Revit material attributes are not imported in the current version of SAP2000: 

• Damping Ratio 

• Bending Reinforcement 

• Shear Reinforcement 

• Resistance Calculation Strength 

• Shear Strength Reduction 

•  Steel Reduction Factor 

Only those materials associated with walls, framing, or floors in the Revit project are imported into 
SAP2000. 

3.1.3 Structural Column and Framing Elements 

The following Revit structural column and framing element attributes are imported into SAP2000: 

• End Points: For straight column and framing elements and curved framing elements other than 
arc shaped, the coordinates of the end points of the lines defining the analytical model of the 
element are retrieved and SAP2000 joint objects with identical coordinates are located or 
created as needed. SAP2000 views two joints as coincident if none of their coordinates differ 
by more than 1/100th of a foot. This level of precision corresponds to the level of precision in 
the Revit database. When the analytical model of an element includes rigid links, the SAP2000 
joint objects are created at the ends of the rigid links with SAP2000 joints offsets created to 
model the link. For arc shaped framing elements, the coordinates of the end points of the 
elements themselves are imported instead of the end points of their analytical models because 
these analytical models consist of series of short straight segments and such a tessellation is 
not required in SAP2000. Columns are imported with the Local Axis 1 always pointing up, 
and beams and braces with their Local Axis 1 always in the first quadrant, which means that 
the end joints may have been switched compared to the Revit end points. 

• Curvature: Straight elements are imported as straight SAP2000 frame objects. Curved framing 
elements that are not arc shaped are imported as series of short SAP2000 objects based on the 
lines defining their analytical models. Arc shaped framing elements are imported as arc shaped 
SAP2000 line objects. 
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• Family Type:  See Frame Object Properties below. 

• End Releases: All frame releases defined in Revit are imported into SAP2000 as line object 
releases. Releases that cause model instability are restrained and a warning is reported in the 
log file. 

• Beam or Brace Justification: In Revit, the insertion point of a framing element is defined by 
the following two parameters: 

o y-Direction Justification 

o z-Direction Justification 

SAP2000 calculates the corresponding cardinal point based on these two parameters. If these 
parameters are not defined, then the default cardinal point (middle center) is chosen. 

• Column Orientation and Beam and Brace Cross-Section Rotation: This angle measures the 
rotation of the member around its longitudinal axis in Revit and sets the value of the “Rotation 
about 1” angle in elements imported into SAP2000. The two angles are measured identically 
in both programs except they differ by 90⁰ in the case of columns. 

The following Revit frame member attributes are not imported into the current version of SAP2000: 

• Column Beam and Brace Vertical End Offsets: Revit column beams and brace vertical end 
offsets are not imported into SAP2000 because Revit element end points are retrieved from 
their analytical models.  

• Column Insertion Point: The cardinal point of imported columns is always middle center.  

3.1.4 Structural Column and Framing Element Sections 

Structural column and frame element sections are defined in Revit by their assigned family type.  

When reading an .exr file, SAP2000 attempts to match each Revit frame member family type to an 
identically named section profile defined in the AISC13.pro file (or AISC13M.pro depending on the 
display unit system in use when importing begins).  

In the absence of such a match, SAP2000 checks if the type is from one of the parametric families 
(Table 2) for which it knows how to generate sections for.  

Any frame member type not matched becomes an unrecognized type for which SAP2000 requires 
additional user input.  

This additional input is entered in the Import Revit .exr file form displayed when an import into 
SAP2000 begins. Here all unrecognized types are listed in a table, allowing them to be manually 
matched to predefined SAP2000 section profile names or, as a last resort, to the SAP2000 “None” 
property. 
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Here additional section properties databases (.PRO files) can be loaded. When adding a properties 
file (.PRO), the unrecognized Revit types are checked against the section profile names in this file. 
This may resolve most of the unrecognized types if the correct properties file (.PRO) is chosen. 

SAP2000 saves the properties files (.PRO) manually loaded and the manual assignments made here 
in a file with an .EXRMap extension. When importing into SAP2000 the same Revit project again, 
SAP2000 will automatically restore these choices. 

When loading an .exr file, SAP2000 keeps track of which materials are used in conjunction with 
which section profiles. When a section profile is always used with the same material, the 
corresponding section property is named after the profile. If a section profile is used with a number 
of different materials, the various corresponding section properties will have compound names 
consisting of the profile name with the relevant material name appended. 

The parameters for concrete and wood structural families are listed in the table below: 

Member Type Family Name Parameters 

CONCRETE 
COLUMNS 

CONCRETE-RECTANGULAR-
COLUMN 

B, H 

 CONCRETE-ROUND-COLUMN B 

 
CONCRETE-SQUARE-
COLUMN 

B 

 
PRECAST-RECTANGULAR 
COLUMN 

B, H CHAMFER 
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CONCRETE 
FRAMING 

PRECAST-DOUBLE TEE WIDTH, TEE WIDTH, 
STEM WIDTH, SLAB 
DEPTH, DEPTH 

 PRECAST-INVERTED TEE H1, H, B, SEAT 

 PRECAST-L SHAPED BEAM H1, H, B, SEAT 

 
PRECAST-RECTANGULAR 
BEAM 

B, H 

 
PRECAST-SINGLE TEE WIDTH, STEM 

WIDTH, SLAB DEPTH, 
DEPTH 

WOOD 
COLUMNS 

DIMENSION LUMBER-
COLUMN 

B, D, SY, SX, IY, IX, A 

 
GLULAM-SOUTHERN PINE-
COLUMN 

B, D, SY, SX, IY, IX, A 

 
GLULAM-WESTERN SPECIES-
COLUMN 

B, D, SY, SX, IY, IX, A 

 
PSL-PARALLEL STRAND 
LUMBER-COLUMN 

B, D, SY, SX, IY, IX, A 

 TIMBER-COLUMN B, D, SY, SX, IY, IX, A 

WOOD FRAMING DIMENSION LUMBER B, D, SY, SX, IY, IX, A 

 GLULAM-SOUTHERN PINE B, D, SY, SX, IY, IX, A 

 GLULAM-WESTERN SPECIES B, D, SY, SX, IY, IX, A 

 
LVL-LAMINATED VENEER 
LUMBER 

B, D, SY, SX, IY, IX, A 

 TIMBER B, D, SY, SX, IY, IX, A 

 OPEN WEB JOIST B, H 

 PLYWOOD WEB JOIST B, H 

 
Table 2: Parameters used in SAP2000 
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3.1.5 In-place Family Members 

Revit in-place family members are not imported into the current version of SAP2000. 

3.1.6 Walls 

Revit walls are imported into SAP2000 as area objects. The following Revit wall attributes are 
imported into SAP2000: 

• Analytical Model End Points: The point coordinates are used to locate matching joints already 
created, and when none are found, create new joints.  

• Wall Curves: Curved vertical Revit walls are imported as a series of short planar SAP2000 
area objects. Revit controls how the curve is broken into segments. 

• Wall Openings (Regular rectangular shape):  This refers to wall openings drawn with the Revit 
selection Modeling>Opening>Wall Opening. These openings are imported into SAP2000 as 
area objects, with “None” properties, that overlap the area object generated for the wall. 

• Wall Thickness and Material: Revit walls may consist of different layers with different 
thickness and materials. The thickness and material type of the layer with the maximum 
thickness are used to find or create an appropriate SAP2000 thick shell property. Wall section 
properties are named after the Revit wall types. The suffix “-WALL” is appended to this name 
if the name is also used for a floor type. 

Warped walls with more than four sides not imported. Slanted walls do not have an analytical model. 

3.1.7 Floors 

Revit floors are imported into SAP2000 as area objects. The following Revit floor attributes are 
imported into SAP2000: 

• Analytical Model End Points: The point coordinates are used to locate matching joints already 
created, and when none can be found, create new joints.  

• Floor Curves: SAP2000 does not support curved edges in area objects. All curves in Revit 
floors are approximated as a series of straight segments. Revit controls how the curve is 
segmented. 

• Floor Thickness and Material: Revit floors may consist of different layers. If there is only one 
layer, its thickness and material are used to define an equivalent SAP2000 thick shell property. 
If there is more than one layer, and one of the layers corresponds to a Revit deck profile and 
at least one other is a concrete layer, SAP2000 creates a concrete thick shell property. Its 
thickness is equal to the total thickness of all the concrete layers and the membrane and 
bending stiffness modifiers assigned will account for the presence of deck ribs. Floor section 
properties are named after the Revit floor types. 

• Floor Span Direction:  Sets the SAP2000 area object local axes.  



CSiXRevit 2021 Revit and SAP2000 Data Exchange 

Revit and SAP2000 Data Exchange 54 

• Inclined Slabs: Also imported into SAP2000 as area objects. 

3.1.8 Openings 

Revit openings are imported into SAP2000 as area objects with “None” properties. This includes: 

• Floor Openings 

• Wall Openings 

• Shaft Openings: These are imported as SAP2000 area objects located at the base of the shaft 
with “None” properties.  

3.1.9 Footings 

Revit footings are not imported in the current version of SAP2000. 

3.1.10 Point Loads 

The following Revit point load attributes are imported into SAP2000: 

• Load Case Name: Sets the load pattern name in SAP2000. 

• Location: The point coordinates are used to locate a matching joint already created. SAP2000 
views a joints and a point load as coincident if none of their coordinates differ by more than 
1/20th of a foot. This level of precision corresponds to the level of precision in the Revit 
database.  When no coincident joint is found, SAP2000 looks for an underlying frame object. 
If no suitable frame object is found, SAP2000 creates a new joint. This new joint creates model 
instability that needs to be addressed. 

• Fx, Fy, Fz, Mx, My, Mz: All forces and moments are defined in the global coordinates system 
in Revit and defined in SAP2000 in a similar manner. 

3.1.11 Line Loads 

The following Revit line load attributes are imported into SAP2000: 

• Load Case Name: Sets the corresponding load case name in SAP2000. 

• Start and End Point Locations: These define the start and end points of the line load. A line 
load overlapping more than one frame object is distributed on the corresponding frame objects. 
If all or part of the load cannot be assigned to frame objects, new frame objects with “None” 
properties are created. This will cause model instability if the load does not also line up with 
any imported floor or wall. 

• Fx, Fy, Fz, Mx, My, Mz: All forces and moments are defined in the global coordinates system 
in Revit and defined in SAP2000 in a similar manner. 
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3.1.12 Area Loads 

Revit area loads are not imported in the current version of SAP2000. 

3.1.13 Load Cases 

Revit load cases are imported into SAP2000 as both load patterns and load cases. One load pattern 
and one load case are both created in SAP2000 for each Revit load case. The following Revit load 
case attributes are imported into SAP2000: 

• Load Case Name: Sets the corresponding load case name in SAP2000. 

• Load Case Category: This defines the load case type in SAP2000. The mapping is shown in 
the following table: 

Revit Load Case Category SAP2000 Load Case Type 

Dead Dead 

Live Live 

Wind Wind 

Snow Snow 

Roof Live Live 

Accidental Other 

Temperature Temperature 

Seismic Quake 

3.1.14 Load Combinations 

The following Revit load combination attributes are imported into SAP2000: 

• Load Combination Name: The same name is used in SAP200. 

• Load Cases: The same load case list is used in SAP2000. 

• Load Case Factors: The same load case factors are used in SAP2000. 
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3.2 Importing from SAP2000 to create a new Revit Project 

The table below provides an overview of the data transferred from SAP2000 to Revit:  

Action Model Element Supported Notes 

Creation of…       

 Grid Lines   Does not transfer. 

 Joints  Does not transfer, but force joint loads transfer. 

 

Materials (isotropic) 

  

Creates material. Limitation is the Revit project 
should have one default concrete and one default 
steel material for duplication, otherwise the 
material will be created in Revit but its 
parameters will not be updated, and the property 
of the new materials are identical to those of the 
template materials. 

 
Materials 
(orthotropic)  

Does not transfer. 

 Frames    

 Vertical Frames  Creates as columns in Revit.  

 Horizontal Frames  Creates as beams in Revit.  

 Other Frames  Creates as braces in Revit.  

 
Cables 

 
Imports as columns, beams, or braces based on 
their alignment. 

 Frame Sections   Creates and maps equivalent Revit sections. 

 “None”  Does not transfer frame object. 

 Tapered Sections  Does not transfer frame object. 

 
Steel Sections 

  . 

 

Joists 

 

Maps to Revit family types with matching names. 
If not loaded, family type is located and if found, 
loaded. 

 Concrete Sections   Creates and maps equivalent Revit sections.  

 
SAP2000 Auto 
Select Lists  

Does not transfer. 

 Shells   

 Vertical Shells   Imports as walls in Revit. 



CSiXRevit 2021 Revit and SAP2000 Data Exchange 

Revit and SAP2000 Data Exchange 57 

 Horizontal Shells  Imports as floors in Revit. 

 

Shells in planes 
inclined up to 45° 
from vertical.  

Non-rectangular shells not imported. Rectangular 
slanted shells with a horizontal base imported as 
slanted walls, but without an analytical model as 
this is not available for such walls in Revit. 

 

Shells in planes 
inclined up to 45° 
from horizontal  

Imports in Revit as floors with a slope. 

 Non-planar shells  Does not transfer. 

 Shell Properties    

 “None”  Does not transfer the shell. 

 Membrane  Does not transfer stiffness modifiers. 

 Plate  

 Shell  

 Layered  Does not transfer. 

 Planes   

 Vertical Planes  Imports as walls in Revit. 

 Horizontal Planes  Imports as floors in Revit. 

 Other Planes  Imports in Revit as floors with a slope.  

 ASolids   Does not transfer. 

 Solids  Does not transfer. 

 Link/Support  Does not transfer. 

 Tendons  Does not transfer. 

 Joint Loads    

 
Force 

 
Loads defined in coordinate systems other than 
local or global do not transfer. 

 Displacement  Does not transfer. 

 Frame Loads    

 Concentrated  Loads defined in coordinate systems other than 
local or global do not transfer.  Distributed  

 Temperature  Does not transfer. 

 Strain  

 Target Force  Does not transfer. 
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 Internal Force  

 
Shell and Plane 
Loads    

 Uniform  Loads defined in coordinate systems, other than 
local or global do not transfer.  Uniform to Frame  

 Surface Pressure  

 Pore Pressure  Does not transfer. 

 Temperature  

 Strain  

 

Load Patterns 

 

Imports as Revit load cases, unless their type does 
not correspond to a predefined Revit load case 
category. 

 Load Cases    

 

Static Linear 

 

Imports into Revit only if all static linear load 
cases each refer to a single load pattern. Load 
patterns not imported into Revit are not included 
in the list of Revit load cases. 

 
Other than Static 
Linear  

Does not transfer. 

 

Load Combinations 

  

Imports as Revit load combination only if it refers 
to more than one load pattern. Load patterns not 
imported into Revit are not included in the list of 
Revit load cases. 

3.2.1 Grid Lines 

SAP2000 grid lines are not imported into Revit. 

3.2.2 Joints 

While model geometry is imported into Revit, SAP2000 joints themselves are not imported. This 
restriction includes supports. 

3.2.3 Materials 

CSiXRevit creates Revit materials with the same names as the SAP2000 materials if they are not 
already in the project template: 

• Material Name: The same name is used in Revit. 
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• Material Type: Concrete and steel set to equivalent Revit material classes. Aluminum, Cold-
formed steel and Other set to Revit Generic material class.  

• Concrete Compressive Strength: In the case of a concrete material, CSiXRevit attempts to 
create a new concrete material which duplicates a Revit concrete material with the same 
concrete compressive strength if it can find one in the project template. If not, a new concrete 
material is created but its concrete compressive strength differs from the original SAP2000 
value. 

• Lightweight Concrete:  In the case of a concrete material, sets the corresponding Revit 
attribute. 

• Minimum Yield Stress: In the case of a steel material, CSiXRevit attempts to create a new 
steel material which duplicates a Revit steel material with the same minimum yield stress if it 
can find one in the project template. If not, a new steel material is created but its minimal yield 
stress differs from the original SAP2000 value. 

Only materials associated with exported SAP2000 frame, cable, and area objects are imported into 
the new Revit project. 

3.2.4 Frame Objects 

SAP2000 frame objects are imported into Revit as columns, beams, or braces depending on whether 
they are vertical, horizontal, or inclined. Frame object with “None” properties, non-prismatic 
properties, or a material that cannot itself be exported are not imported into Revit. The following 
SAP2000 frame member attributes are imported into Revit: 

• Name: The SAP2000 name is imported into Revit as a shared parameter. 

• Start and End Joints: The coordinates of their start and end joints set the end points of the new 
Revit columns, beams, or braces. 

• Frame Releases: See Limitations. 

• Insertion Point: The insertion points of SAP2000 frame objects that are not vertical are 
imported into Revit as Z-Direction or Lateral Justification attributes. Revit columns do not 
feature these attributes and as a result, the insertion points of SAP2000 vertical frame objects 
are not imported 

• Local Axes: Sets Revit Column Orientation and Beam and Brace Cross-Section Rotation. 

• Frame Joint Offsets, End Length Offsets: The end points of the new Revit columns, beams, or 
braces are adjusted based on these. 

3.2.5 Frame Object Section Properties 

This section explains how CSiXRevit maps SAP2000 frame object section properties to Revit 
structural column and framing element family types: 
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• If the Revit project into which the SAP2000 model is being imported already contains a Revit 
family type with the same name as the section properties of SAP2000 frame object, the 
SAP2000 frame object with these properties are imported with that Revit family type. The 
name comparison is not case-sensitive. Note that if you import an SAP2000 model into Revit, 
and later redefine a given SAP2000 frame section and then re-import the SAP2000 model, 
CSiXRevit will not redefine the corresponding Revit family type. 

• If the type of the frame section is one of the section shape types listed in Table 4 or Table 5, 
CSiXRevit creates a new type of the corresponding Revit family in the Revit project based on 
the original SAP2000 section dimensions, and the SAP2000 frame object with that frame 
section are imported with that Revit family type. 

• If the above did not apply, CSiXRevit looks for a pre-defined family type with a matching 
name in the active Revit content libraries, and if it finds one, loads that family type in the Revit 
project and the SAP2000 frame objects with that frame section are imported with that Revit 
family type.   

• If the above still did not work, CSiXRevit looks for a pre-defined family type whose name 
includes the name of the frame section in the active Revit content libraries, loads that family 
type in the Revit project and the SAP2000 frame object with that frame section are imported 
with that Revit family type.   

• If none of the above applied, the SAP2000 frame objects are assigned a default Revit family 
type.  You can specify any family type already in the project or any pre-defined family type 
listed in the active Revit content libraries as a replacement. 

Note that you can specify which Revit content libraries are active with the File->Options command, 
under the File Locations tab and Places… button. 

 

  



CSiXRevit 2021 Revit and SAP2000 Data Exchange 

Revit and SAP2000 Data Exchange 61 

SAP2000 Section Shape Revit Family 

Steel angle  L-Angle-Column.rfa, M_L-Angle-Column.rfa 

Steel box  HSS-Hollow Structural Section-Column.rfa, 
M_HSS-Hollow Structural Section-Column.rfa 

Steel channel C-Channel-Column.rfa, M_C-Channel-Column.rfa 

Steel double channel Double C-Channel-Column.rfa, 
 M_Double C-Channel=Column.rfa 

Concrete circular Concrete-Round-Column.rfa, M_Concrete-Round-Column.rfa 

Steel I-shaped W-Wide Flange-Column.rfa, M_W-Wide Flange-Column,rfa 

Steel pipe Pipe Column.rfa, M_Pipe Column.rfa 

Concrete rectangular Concrete-Rectangular-Column.rfa 

Concrete square Concrete-Square-Column.rfa, M_Concrete-Square-Column.rfa 

Table 4: SAP2000 Vertical Frame Object Section Shapes with preset Revit equivalent Families 

SAP2000 Section Shape Revit Family 

Concrete angle  Precast-L Shaped Beam.rfa, M_Precast-L Shaped Beam.rfa 

Steel angle L-Angle.rfa, M_L-Angle.rfa 

Steel double angle LL-Double Angle.rfa, M_LL-Double Angle.rfa 

Steel box  HSS-Hollow Structural Section.rfa, 
M_HSS-Hollow Structural Section.rfa 

Steel channel C-Channel.rfa, M_C-Channel.rfa 

Steel double channel Double C-Channel.rfa, M_Double C-Channel.rfa 

Concrete I-shaped Precast-I Shaped Beam.rfa, M_Precast-I Shaped Beam.rfa 

Steel I-shaped W-Wide Flange.rfa, M_W-Wide Flange.rfa 

Steel pipe HSS-Round Structural Tubing.rfa, 
M_HSS-Round Structural Tubing.rfa 

Steel plate Plate.rfa, M_Plate.rfa 

Concrete rectangular Concrete-Rectangular Beam.rfa,  
M_Concrete-Rectangular Beam.rfa 

Steel rod Round Bar.rfa, M_Round Bar.rfa 

Concrete tee Precast-Single Tee.rfa, M_Precast-Single Tee.rfa 

Steel tee St-Structural Tee.rfa, M_St-Structural Tee.rfa 

Table 5: SAP2000 Non-Vertical Frame Object Section Shapes with preset Revit equivalent Families  
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3.2.6 Cable Objects 

SAP2000 cable area objects are imported into Revit as columns, beams, or braces depending on 
whether they are vertical, horizontal, or inclined. Cable area object with “None” properties or a 
material that cannot itself be exported are not imported into Revit. The following SAP2000 cable 
area object attributes are imported into Revit: 

• Name: The SAP2000 name is imported into Revit as a shared parameter. 

• Start and End Joints: The coordinates of their start and end joints set the end points of the 
Analytical Models of the new Revit columns, beams, and braces. 

• Properties:  The name of SAP2000 properties is exported. When importing cable area objects 
from an .exr files into Revit, CSiXRevit always attempts to locate and load a Revit family type 
with the same name. 

3.2.7 Area Objects 

SAP2000 area objects are imported into Revit in different ways based on their orientation. Vertical 
area objects are imported into Revit as walls. Horizontal area objects are imported into Revit as 
floors. Other planar area objects are imported into Revit as floors with a slope. Non-planar area 
objects, area objects with “None” properties, or with layered properties, are not imported into Revit. 
The following SAP2000 shell and plane attributes are imported into Revit: 

• Name: The SAP2000 name is imported into Revit as a shared parameter. 

• Joints: Their coordinates set the corners of the new Revit wall or floor analytical model. In the 
case of area objects that are neither vertical nor horizontal, floors with a slope are created in 
Revit. Note that while their slope is initially set correctly, Revit subsequently resets it to a 
different value. The correct slope is available as a shared parameter named “Computed slope” 
and you need to reset the slope of the floor to this parameter value. 

• Properties: SAP2000 shell, membrane, plate, and plane properties are imported into Revit as 
wall or floor type and as a single layer. The thickness and material matches the SAP2000 
thickness and material. Note that stiffness modifiers are not exported.  

3.2.8 Solid Objects, ASolid Objects, Link/SupportObjects, Tendon Objects 

SAP2000 Solid objects, ASolid objects, Link/Support objects, and Tendon objects are not imported 
into Revit. 

3.2.9 Force Joint Loads and Frame object Concentrated Loads 

SAP2000 force joint loads and frame object concentrated loads are imported into Revit as point 
loads. Not all force joint loads are imported: see Load Pattern and Coordinate System below. The 
following SAP2000 force joint load attributes are imported into Revit: 
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• Load Pattern: It sets the Revit load case name. Loads part of a load pattern that is not itself 
exported are not imported into Revit. 

• Coordinate System: Joint loads and frame object concentrated loads defined in coordinate 
systems other than the local joint coordinate system or the model global coordinate system are 
not imported into Revit. 

• Force X, Force Y, Force Z, Moment about X, Moment about Y, and Moment about Z: Set the 
values of Fx, Fy, Fz, Mx, My, Mz in Revit. 

Ground displacement joint loads are not imported into Revit. 

3.2.10 Frame Object Loads 

Frame object distributed loads are imported into Revit as line loads.  Distributed loads consisting of 
a sequence of trapezoidal loads are imported as multiple loads with one Revit line load for each 
trapezoidal segment. Not all force joint loads are imported: see Load Pattern and Coordinate System 
below. The following SAP2000 frame object load attributes are imported into Revit: 

• Load Pattern: It sets the Revit load case name. Loads part of a load pattern that is not itself 
exported are not imported into Revit. 

• Coordinate System: Frame object distributed loads defined in coordinate systems other than 
the local joint coordinate system or the model global coordinate system are not imported into 
Revit. 

• Load Type, Direction and Load: Set the values of Fx1, Fx2, Fy1, Fy2, Fz1, Fz2, Mx1, Mx2, 
My1, My1, My2, Mz1, and Mz2 in Revit. Projected load magnitudes are converted to absolute 
load magnitudes based on the geometry of the frame object. 

Temperature, strain, target force and internal force frame object loads are not imported into Revit. 

3.2.11  Area Object Loads 

Area object uniform, uniform to frame, and surface pressure loads are imported into Revit as area 
loads. Not all force joint loads are imported: see Load Pattern and Coordinate System below. The 
following SAP2000 area object loads attributes are imported into Revit:  

• Load Pattern: It sets the Revit load case name. Loads part of a load pattern that is not itself 
exported are not imported into Revit. 

• Coordinate System: Area Object distributed loads defined in coordinate systems other than the 
local joint coordinate system  or the model global coordinate system are not imported into 
Revit. 

• Load Direction and Load: Set the value of Fx1, Fy1, Fz1, in Revit. Projected load magnitudes 
are converted to absolute load magnitudes based on the geometry of the area object. 
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Area object temperature loads, strain loads, and pore pressure loads are not imported into Revit. 

3.2.12  Load Patterns 

SAP2000 load patterns with types corresponding to a predefined Revit load case category are 
imported into Revit as load cases. The following SAP2000 load pattern attributes are imported into 
Revit: 

• Load Pattern Name: The same name is used in Revit. 

• Load Case Type: It sets the Revit load case nature and category. The mapping is shown in the 
following table: 

SAP2000 Load Case 
Type 

Revit Load Case 
Category 

Dead, Super Dead Dead 

Live, Reducible Live, 
Pattern Live 

Live 

Roof Live, Ice Roof Live 

Snow Snow 

Wind Wind 

Quake Seismic 

Temperature, 
temperature gradient 

Temperature 

Other  Not exported 

Not listed above Not exported 

 

Load patterns with types that do not correspond to any predefined Revit load case category are not 
imported into Revit, and neither are any of their constituent loads. 

3.2.13  Load Cases 

If any SAP2000 static linear load case refers to more than one load pattern, than the static linear load 
cases are imported into Revit as load combinations, in place of the SAP2000 load combinations. The 
following SAP2000 load case attributes are imported into Revit: 

• Load Case Name: The same name is used in Revit. 
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• Load Patterns: Set the list of Revit load cases. Load patterns not imported are not included in 
the Revit list.  

• Load Pattern Factors:  Identical load case factors are used in Revit, unless the load pattern list 
includes load patterns that were not exported. Their factors are not imported into Revit. 

SAP2000 load cases that are not static or are not linear are not imported into Revit. 

3.2.14  Load Combinations 

If all the SAP2000 static linear load cases each refer to a single load pattern, then the SAP2000 load 
combinations are exported as Revit load combinations. When load combinations are exported, their 
following attributes are exported: 

• Load Combination Name: The same name is used in Revit. 

• Load Cases:  Sets the list of Revit load cases. The Revit list is made of the load pattern names 
that each load case in the SAP2000 list refers to.  Load patterns not imported are not included 
in the Revit list. 

• Load Case Factors: If all the load cases in the list of load cases refer to their load patterns with 
a scale factor of 1, the same load case factors are used in Revit. If any load case refers to a 
load pattern with a scale factor other than 1, the Revit load case factors are adjusted 
accordingly. Scale factors for load patterns not imported are not included. 
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3.3 Procedures 

3.3.1 Exporting from Revit to create a new SAP2000 Model 

NOTE: CSiXRevit only exports the analytical models of Revit elements. All the analytical models 
of all Revit elements must be correctly connected to others to ensure the stability of the SAP2000 
model generated. 

The following steps describe how to export a Revit analytical model into SAP2000: 

• With Revit running, open a project you want to export. 

• From the Revit menu, select Tools>External Tools>Export to Create New ETABS or 
SAP2000 Model.  

• CSiXRevit counts the objects in the Revit project and displays the Export to Create New 
ETABS or SAP2000 Model form: 

 

• Select the categories of Revit elements to export. If you have selected some elements prior to 
starting the command and wish to only export these elements, check the corresponding box 
near the bottom of the form.  

• To export to SAP2000 v21, check the corresponding box near the bottom of the form. 
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• Once you have made your selections, click OK. The Exporting to Create New ETABS 
SAP2000 or SAFE Model or Exporting to Update Existing ETABS or SAFE model 
information message box is shown and displays the progress of the export: 

 

• Once the process is complete, click OK. You are now asked to select a destination folder and 
filename. The file will be given the extension .exr.  

• Start SAP2000 if it is not already running. If it is already running and you want to retain the 
changes you made to the current model, save the current model. 

• Select a SAP2000 unit system. If any issues arise during the import part of the exchange, 
SAP2000 generates a log file in which the locations of the problematic elements are reported 
in meters if you select metric units, or in feet otherwise. 

• From the menu, select File>Import>Revit Structure .exr File. The Import Revit Structure 
.exr file form is displayed. Click the Browse… button in the Read Revit .exr File field, and 
select the .exr file to import. 
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• If some of the family types of the Revit structural column and framing element in the .exr file 
are not recognized, a warning box is displayed: 

 

• A summary of the contents of the .exr file is displayed. If some of the family types of the Revit 
structural column and framing element in the .exr file are not recognized, the form includes a 
table listing all unrecognized types: 

 

The default SAP2000 profile selected in the right column for each unrecognized type in the 
left column is the closest alphabetical match in AISC14.pro (or AISC14M.pro depending on 
the unit system in use when the import began). 



CSiXRevit 2021 Revit and SAP2000 Data Exchange 

Revit and SAP2000 Data Exchange 69 

• Click the Browse…  button in the Add Sections Database field to load another SAP2000 
section properties database (.pro file). The Revit types that now have a name match – like 
UB254x120x28 in the example depicted above – are removed from the list: 

 

• You can load additional section properties databases as needed. 
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• For each unknown Revit type in the left column, if the corresponding SAP2000 section profile 
in the right column is not what you want, you can specify another one from the drop-down list 
of profiles already loaded:  
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“None” SAP properties are always available at the top of the list. 

SAP2000 saves your choices in a file which has an .EXRMap extension. Importing the same 
Revit project again restores your choices. 

• Select the element categories to import by checking or unchecking the relevant check boxes. 
(If checking Area Loads, you will receive a reminder that Area Loads cannot be imported into 
the current version of SAP2000.) 

• Click the Import in SAP2000 button. 

After a few moments, SAP2000 displays the newly imported model.  

• If any issues arise during the import part of the exchange, you will be prompted to review the 
log file.  

  



CSiXRevit 2021 Revit and SAP2000 Data Exchange 

Revit and SAP2000 Data Exchange 72 

3.3.2 Importing from SAP2000 to create a New Revit Project 

The following steps describe how to export a SAP2000 model to create a new Revit project: 

• With SAP2000 running, open a model you want to export. 

• Select File>Export>Revit Structure .exr File. The Export Revit Structure .exr File form is 
displayed. It includes a summary of the model contents on the left side and a table with level 
names on the right side: 

  

• Unlike ETABS or Revit, SAP2000 does not include the concept of story levels because it is a 
general-purpose analysis program. Therefore, Revit levels need to be created when a SAP2000 
model is imported into Revit. The form gives you control over which levels are created, their 
names, their elevations, and how exported SAP2000 objects are assigned to them in Revit. 
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• If the joints in the SAP2000 model occur at many different z elevations, you will probably 
want to create Revit levels only for a small subset of these elevations. In that case, uncheck 
the check box at the top of the levels table. It unchecks all the levels at once: 

 

• Check the box next to each story level you want created. As you check levels, SAP2000 
computes default cutoff elevations and displays them in the “At or Below” field. SAP2000 
area objects are imported into Revit as walls, floors, or ramps and SAP2000 frame and cable 
objects are imported into Revit as columns, beams or braces. The top and bottom levels of 
these Revit walls, columns and braces, and the reference levels of these beams and slabs are 
assigned based on the relationship between the level cutoff elevations and the z-coordinates 
of the joints defining the original SAP2000 objects. 

• You can override any cutoff elevation by typing over a new elevation and pressing the TAB 
key – as long as you do not set it lower than the corresponding level elevation, or higher than 
the elevation of the next level to be created above. 
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• Likewise, you can rename any level by typing a new name, and change its elevation by typing 
a new elevation: 

 

SAP2000 saves your level data in a file which has an .EXRMap extension. Exporting the same 
SAP20000 model again restores your level data.  

• Select what to export by checking or unchecking the relevant check boxes. 

• The Metric check box controls the units in which level elevations are displayed, the family 
names of the concrete section types created in Revit, and the units of the log file. 

• By default, the .exr file written is written in the same folder as the model and its name is the 
name of the model with an .exr extension. To save the .exr file in a different folder or under a 
different name, click the Browse... button.  

• Click the OK button. 

• If any issues arise during the export part of the exchange, you will be prompted to review the 
log file. Please take a moment to do so. 

You are now ready to import the .exr file in Revit. You import an .exr file written by SAP2000 
exactly like an .exr file written by ETABS, as explained in Importing from ETABS to Create/Update 
a New/Existing Revit Project. 

3.3.3 Known Limitations of CSiXRevit with SAP2000 

• Materials imported into Revit from SAP2000 may not always be properly mapped or the 
property values may not always be properly transferred. For this reason, material mapping and 
material property values should always be carefully checked in Revit after importing from 
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SAP2000. 

• See other limitations described in the previous sections for SAP2000.  
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4 Revit and SAFE Data Exchange 

Data can be exchanged between Revit and SAFE along the following paths: 

• Exporting from a Revit project to create a new SAFE model. 

• Exporting from a Revit project to update a previously exported or previously imported SAFE 
model. 

• Importing from a SAFE model to create a new Revit project. 

• Importing from SAFE to update a previously imported or previously exported Revit project. 

The actual data transferred varies in each case. 

4.1 Exporting from Revit to create a new SAFE model 

The table below provides an overview of the data imported in SAFE when exporting from Revit to 
create a new SAFE model: 

Action Project Element Supported Notes 

Creation of…       

 Grid Lines    

 Story Levels  Lets you select which horizontal slice of the 
project to import. 

 Materials    

 Structural Columns and 
Structural Framing 

  Imports only concrete columns, braces and 
beams, and only columns with rectangular or 
circular section, and only beams with 
rectangular section. 
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 Steel Column and 
Framing Family Types 

   

 Concrete Column and 
Framing Family Types 

  Imports only circular or rectangular column 
sections, and only rectangular beam sections. 

 Walls   Slanted or warped walls not imported. Slanted 
walls do not have an analytical model in Revit. 

 Wall Family Types   Creates and maps equivalent SAFE wall 
sections. 

 Wall Openings   

 Floors   Floors with a filled steel deck or made of a 
material other than concrete not imported. 
Sloped floors with more than four outer 
corners are projected on a horizontal plane. 

 Floor Family Types   Creates and maps equivalent SAFE slab and 
deck sections. 

 Floor Openings   

 Footings    

 Point Loads    

 Line Loads    

 Area Loads   Non-uniform area loads not imported. 

 Load Cases   Creates both a SAFE load pattern and load 
case for each Revit load case.  

 Load Combos    

4.1.1 Grids 

The following Grid attributes are created in SAFE: 

• Grid Name: The same grid name is used in the SAFE grid bubble. 

• Grid Points: The start and end points are used to define the general grid line in SAFE. 

• Curved Grid: The center point, radius, start angle and aperture are used to define the circular 
grid line in SAFE.  

4.1.2 Materials 

The following material attributes are created in SAFE: 

• Material Name: The same name is used in SAFE. 
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• Material Type: The Revit material type is used to identify the SAFE material type, namely 
Concrete, Steel or Other. 

• Young’s Modulus: The Young’s modulus values from Revit set the SAFE material Young’s 
modulus (E). These three values (for the three different directions) cannot be zero in SAFE. If 
the first value is zero, then the default SAFE value is used. If any of the remaining two are 
zero, then the first non-zero value is used. For an isotropic material, the first value is used for 
all other directions. 

• Poisson’s Ratio: Poisson’s Ratio values from Revit set the SAFE material Poisson’s Ratio (u). 
These three values (for the three different directions) cannot be zero in SAFE. If the first value 
is zero, then the default SAFE value is used. If any of the remaining two are zero, then the first 
non-zero value is used. For an isotropic material, the first value is used for all other directions. 

• Shear Modulus: Shear Modulus value from Revit set the SAFE material Shear Modulus (G). 
If the Revit material is defined as isotropic, then SAFE calculates this value on the basis of 
the Young’s Modulus and the Poisson’s Ratio. In the case of an orthotropic material, these 
three values (for the three different directions) cannot be zero in SAFE. If the first value is 
zero, then the default SAFE value is used. If any of the remaining two are zero, then the first 
non-zero value is used.  

• Thermal Expansion Coefficient: The thermal expansion coefficient from Revit sets the SAFE 
material thermal expansion coefficient (Alpha). These three values (for the three different 
directions) cannot be zero in SAFE. If the first value is zero, then the default SAFE value is 
used. If any of the remaining two values are zero, then the first non-zero value is used. For an 
isotropic material, the first value is used for all other directions. 

• Weight Density and Mass Density: The unit weight value from Revit sets the SAFE material 
weight density (w) and mass density (m). In SAFE, the mass density is calculated by dividing 
the weight density by the gravitational constant (g). The weight density cannot be zero in 
SAFE. If the unit weight is zero in Revit, then the default SAFE densities are used.  

• Damping Ratio: This value is not in used in the current version of SAFE. 

• Bending Reinforcement: The bending reinforcement value from Revit sets the SAFE material 
main reinforcement Fy if the type is concrete. If this value is zero in Revit, then the default 
SAFE value is used. 

• Shear Reinforcement: The shear reinforcement value from Revit sets the SAFE material shear 
reinforcement Fy if the type is concrete. If this value is zero in Revit, then the default SAFE 
value is used. 

• Resistance Calculation Strength: The resistance calculation strength from Revit sets the SAFE 
material f’c factor. If this value is zero in Revit, then the default SAFE value is used. 

• Behavior: The Revit behavior tag is used to identify the isotropic or orthotropic materials in 
SAFE. 
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• Concrete Compression: The concrete compression value from Revit sets the SAFE material 
f’c if the type is concrete. 

• Lightweight: The Revit lightweight tag is used to identify the lightweight concrete material in 
SAFE. 

• Shear Strength Reduction: This value is not in used in the current version of SAFE. 

• Yield Stress: This value is not in used in the current version of SAFE. 

•  Tensile Strength: This value is not in used in the current version of SAFE. 

• Steel Reduction Factor: This value is not in used in the current version of SAFE. 

Only those materials linked with floors, walls, or frames in the Revit project are imported into SAFE. 

SAFE writes a warning in the .EXRLog file it writes when a default value is used while importing 
materials from the Revit project. 

4.1.3 Concrete Structural Columns and Framing 

The following Revit column and framing element attributes are imported into SAFE: 

• Frame Curves: Straight framing elements are imported as straight SAFE frame objects. Curved 
framing elements that are not arc shaped are imported as series of short SAFE objects based 
on the lines defining their analytical models. Arc shaped beams are imported as arc shaped 
SAFE beams.  

• Frame End Points and Curves: For straight column and framing elements and curved framing 
elements other than arc shaped, the coordinates of the end points of the lines defining the 
analytical model of the element are retrieved and SAFE joint objects with identical coordinates 
are created. When the analytical model of an element includes rigid links, the SAFE joint 
objects are created at the ends of the rigid links with SAFE joints offsets created to model the 
link. For arc shaped framing elements, the coordinates of the end points of the elements 
themselves are imported instead of the end points of their analytical models because these 
analytical models consist of series of short straight segments and such a tessellation is not 
required in SAFE. Columns are imported with the Local Axis 1 always pointing up, and beams 
and braces with their Local Axis 1 always in the first quadrant, which means that the end joints 
may have been switched compared to the Revit end points.  

• Frame Sections: Only columns with rectangular or circular sections and beams with 
rectangular sections can be imported.  

• End Releases: End releases defined in the element analytical models are imported into SAFE. 
SAFE restricts releases that would cause an analytical instability, such as for example torsion 
released at both ends. When that happens, SAFE writes a warning in the .EXRlog file it writes. 
When SAFE joints have been switched compared to Revit end points, end releases are also 
switched. 
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• Insertion Points: In Revit, the beam insertion point is defined by the following two parameters: 

o Z-Direction Justification 

o Lateral Justification 

SAFE calculates the corresponding cardinal point on the basis of these two parameters. If these 
parameters are no defined for a beam then the default cardinal, Top Center, is chosen. Columns 
and braces are imported with a Middle Center insertion point. 

• End Offsets: When the analytical model of an element includes rigid links, these are imported 
as end offsets. You can visualize them by looking at the model in extruded view. In addition, 
when a beam has its z-Direction Justification parameter set to Other, an additional vertical 
offset is created at both ends of the SAFE frame object based on the value of the z-Direction 
Offset parameter. Other beam offset parameters such as Start Level Offset and End Level 
Offset are not taken into consideration because, except for arc shaped members, end joints are 
located based on the end points of the analytical model which already reflects the values of 
these parameters. When SAFE joints have been switched compared to Revit end points, end 
offsets are also switched. 

• Orientation Angles: The SAFE Local Axis 2 Angle of columns is computed based on their 
rotation as internally stored in Revit. The SAFE Local Axis 2 Angle of beams and braces is 
computed based on the value of their Cross-Section Rotation parameter. When SAFE joints 
have been switched compared to Revit end points, rotations are adjusted accordingly.  

4.1.4 In-place family members 

Revit in-place family members are not imported into SAFE. 

4.1.5 Walls 

The following wall attributes are imported into SAFE: 

• Points: The coordinate of all points defined in the wall analytical model are retrieved and 
SAFE joint objects with identical coordinates are created. Revit walls may be defined as 
having more than four corners, but SAFE walls can only have three or four nodes. Revit walls 
with more than four outer corners are broken into several four node walls, with a few three 
node walls when some of the edges are sloped. Also, multi-story walls are broken into several 
single story SAFE walls. This is required for reporting and concrete reinforcement design. 

• Wall Curve: Arc shaped curved walls with horizontal bases and tops are imported as SAFE 
curved walls. Straight wall edges are imported as such. Other edges are tessellated, with the 
degree of approximation defined internally by Revit, and the wall is imported as a series of 
walls. Note that when a Revit wall is arc shaped in plane but its top is not horizontal, its top 
curve is not an arc and will be tessellated. 

• Wall Openings: Wall openings are not imported in SAFE. 
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• Wall Thickness: A Revit wall has different layers, each having different thickness and material 
properties. SAFE only considers the layer with the maximum thickness when importing the 
data from Revit.  

• Wall Materials: All the materials assigned to the different layers of a Revit wall are imported 
into SAFE. However, only one material is assigned to the SAFE wall section property. Users 
have the option in SAFE to change the material, if necessary. The material of the wall layer 
with the maximum thickness is used.  

Slanted walls, with their top not lined up with the base when looked at from above, are not imported. 

4.1.6 Floors 

The following floor attributes are imported into SAFE: 

• Floor Points: The coordinate of all points defined in the floor analytical model are retrieved 
and SAFE joint objects with identical coordinates are created. 

• Floor Curves: Floor edges that are arc shaped are imported as arcs in SAFE. Straight floor 
edges are imported as such. All other curved floor edges are tessellated, with the degree of 
approximation defined internally by Revit. Floors with more than four outer corners are 
projected onto a horizontal plane at an elevation matching their average elevation. 

• Number of Layers: Floors with a filled steel deck or made of a material other than concrete 
cannot be imported. SAFE only considers the layer with the maximum thickness when 
importing the data from Revit. 

• Layer Thickness:  SAFE only considers the layer with the maximum thickness when importing 
the data from Revit.  

4.1.7 Openings 

The following openings are imported into SAFE from Revit: 

• Horizontal Openings: These are imported as opening in the floors. 

• Wall Openings: These are imported as openings in the walls (vertical planes). 

• Shaft Openings: These are imported as openings in the floors if their vertical extents include 
the story level being imported. 

4.1.8 Point Loads 

The following point load attributes are imported into SAFE from Revit: 

• Load Case Name: It sets the corresponding load case name in SAFE. 

• Location: It is used to define the point of application of the load. 
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• Fx, Fy, Fz, Mx, My, Mz: All forces and moments applied in the global direction, in Revit, are 
transferred in a similar manner into SAFE. 

If a point load is not directly on top of a SAFE wall, column, or beam, a SAFE beam with None 
properties is created to tie the load to the structure. 

4.1.9 Line Loads 

The following line load attributes are imported into SAFE from Revit: 

• Load Case Name: It sets the corresponding load case name in SAFE. 

• Start and End Point Locations: Used to define the start and end point of the line load. Line 
loads carrying the gravitational load and overlapping more than one beam are distributed to 
the corresponding beams in SAFE. In the case of a lateral line load, users must check no line 
load overlaps more than one beam; otherwise it is not processed in the SAFE analysis. 

• Fx, Fy, Fz, Mx, My, Mz: All forces and moments applied in the global direction, in Revit, are 
transferred in a similar manner into SAFE. A Revit line load which includes more than one of 
these components is imported as several SAFE line loads because SAFE line loads are 
unidirectional. 

4.1.10  Area Loads 

The following area load attributes are imported into SAFE from Revit: 

• Load Case Name: It sets the corresponding load case name in SAFE. 

• Points: Points are used to define the geometry of the loading area. Curved edges that are arc 
shaped are imported as arcs. Straight edges are imported as such. Other edges are tessellated, 
with the degree of approximation defined internally by Revit. 

• LoadX, LoadY, and LoadZ: All loads applied in the global direction in Revit are transferred 
in a similar manner into SAFE.  

Non-uniform surface loads are not supported in SAFE and not imported.  

4.1.11  Load Cases 

The following load case attributes are imported into SAFE from Revit: 

• Load Case Name: The same name is used for the SAFE load case. 

• Load Case Category: It is used to define the load case type in SAFE. The mapping is shown 
in the following table: 
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Revit Load Case Category SAFE Load Case Type 

Dead Dead 

Live Live 

Wind Wind 

Snow Snow 

Roof Live Live 

Accidental Other 

Temperature Other 

Seismic Quake 

4.1.12  Load Combos 

The following load combination attributes are imported into SAFE from Revit: 

• Load Combination Name: The same name is used for the SAFE Load Combination Name.  

• Load Cases: The same load cases list is used in SAFE to define the Load Combination. 

• Load Case Factor: The same load case factors are used for the corresponding load cases in the 
SAFE load combination. 
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4.2 Exporting from Revit to update an existing SAFE model 

The table below provides an overview of the data imported in SAFE when exporting from Revit to 
update an existing SAFE model: 

Action Model Element Supported Notes 

Creation of…       

 Grids    

 Story Levels   

 Materials   Creates equivalent SAFE materials.  

 
Frames   Transfers geometry, offsets, y and z 

justifications, and end releases into SAFE.  

 Frame Sections    

 Steel Sections   Maps to SAFE database sections. 

 Concrete Sections   Creates and maps equivalent SAFE sections. 

 Walls    

 
Wall Properties    

 Wall Openings   

 Floors    

 
Slabs Properties    

 Floor Openings   

 
Footings   Creates fixed joint restraints in SAFE wherever 

a footing occurs in Revit. 

 Joint Loads    

 Frame Loads    

 Shell Loads    

 Load Cases    

 Load Combos    

Update of…      

 Grids    

 Story Levels   

 Materials X  
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Frames 

X  

 Frame Sections X  

 Steel Sections X  

 Concrete Sections X  

 
Walls 

X 
Walls with changing number of sides are 
replaced. 

 Wall Properties X  

 Wall Openings  . 

 Floors X  

 Slabs Properties X  

 
Floor Openings 

 
Floor openings with changing number of sides 
are replaced. 

 Point Loads X  

 Line Loads X  

 Area Loads X  

 Load Cases X  

 Load Combos    

Deletion of…      

 Grids    

 Story Levels   

 Frames    

 Walls    

 Wall Openings   

 Floors    

 Floor Openings   

 Footings   

 Point Loads    

 Line Loads    

 Area Loads    

 Load Cases    

 Load Combos    
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NOTE: Deletion of objects when updating a model only works if you are sending the entire model. 
If the “selection only” update feature is used, deletion of items is not supported. 
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4.3 Importing from SAFE to create a new Revit Project 

The table below provides an overview of the data imported in Revit when creating a new Revit 
project: 

Action Model Element Supported Notes 

Creation of…       

 Grids    

 

Materials 

  

Imports Concrete and Steel materials into Revit 
from SAFE. Limitation is the Revit project 
should have one default concrete and one 
default steel material for duplication, otherwise 
the material will be created in Revit but its 
parameters will not be updated, and the 
properties of the new materials are identical to 
those of the template materials. 

 Frames    

 Frame Sections    

 

Concrete Sections 

  

Creates and maps equivalent Revit sections.  

See mapping below. 

 

Walls 

  

Non-rectangular slanted walls and warped 
walls not imported. Rectangular slanted walls 
with a horizontal base imported, but without an 
analytical model as this is not available for such 
walls in Revit. 

 Wall Properties    

 Wall Openings   

 Floors    

 Slabs Properties    

 Footings    

 Load Cases   

 Joint Loads    

 
Frame object Loads 

  
Creates equivalent Revit point line loads and 
trapezoidal line loads. 

 Surface Loads   Creates equivalent Revit area loads. 

 Load Combos    
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 Mapping of SAFE section types to Revit families: 

 

Columns 

SAFE Revit Family 

Rectangular Concrete-Rectangular-Column.rfa 

Square Concrete-Square-Column.rfa 

Circular Concrete-Round-Column.rfa 

 

Beams and Braces 

SAFE Revit Family 

Rectangular or Square Concrete-Rectangular Beam.rfa 
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4.4 Importing from SAFE to Update an Existing Revit Project 

The table below provides an overview of the data imported in Revit when updating an existing Revit 
project: 

Action Model Element Supported Notes 

Creation of…       

 Grids    

 Story Levels   

 Materials    

 Frames   

 Frame Sections    

 Steel Sections    

 

Concrete Sections 

  

Creates and maps equivalent Revit sections.  

See mapping at end of previous section. 

 Walls    

 Wall Properties    

 Wall Openings   

 Floors    

 Slabs Properties    

 Deck Properties   

 Floor Openings   

 Footings    

 Load Cases   

 Joint Loads    

 Line Loads    

 Area Loads    

 Load Combos    

Update of…       

 Grids    

 Story Levels   

 Materials    
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Frames 

  

Updates changes to column locations only for 
columns not meshed in SAFE and with a 1:1 
correspondence between Revit and SAFE. You can 
choose between leaving columns meshed in SAFE 
in their original Revit locations and replacing them 
with the SAFE meshed columns. 

 Frame Sections    

 Steel Sections    

 

Concrete Sections 

  

Updates Beam, Column and Brace section 
assignments; however section parameters 
themselves do not update. If you would like to bring 
in the changes to the parameters from SAFE, create 
a new section with the desired parameters in SAFE 
and assign the new section to the frame.  

 

Walls 

  

Updates changes in wall location only for walls not 
meshed in SAFE and with a 1:1 correspondence 
between Revit and SAFE. You can choose between 
leaving walls meshed in SAFE in their original 
Revit locations and replacing them with the SAFE 
meshed walls. 

 

Wall Properties 

  

Updates wall type assignments; however wall types 
themselves do not update. If a wall section is 
changed in SAFE, it is imported under a new name 
in Revit. 

 Wall Openings  Non-rectangular wall openings are not updated. 

 

Floors 

  

Replaces floors which moved, were not meshed 
when brought in from SAFE, and with a 1:1 
correspondence between Revit and SAFE. You can 
choose between leaving floors meshed in SAFE in 
their original Revit locations and replacing them 
with the SAFE meshed floors. 

 
Slabs Properties 

  
Updates floor type assignments; however floor 
types themselves do not update. If a floor section is 
changed in SAFE, it is imported under a new name 
in Revit.  

Deck Properties 
  

 Floor Openings  Floor openings moved in SAFE are replaced. 

 Load Cases   

 Point Loads    

 Line Loads    
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 Area Loads   Area loads moved in SAFE are replaced. 

 Load Combos    

Deletion of…       

 Grids    

 Story Levels   

 Materials   

 Frames    

 Walls    

 Wall Openings  Non-rectangular wall openings are not deleted. 

 Floors    

 
Floor Openings 

  
Floor openings imported as a floor shaft and 
deleted in SAFE are not deleted. 

 Load Cases   

 Point Loads   

 Line Loads    

 Area Loads    

 Load Combos    

 

NOTE: Deletion of objects when updating a model only works if you are sending the entire model. 
If the “selection only” update feature is used, deletion of items is not supported. 
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4.5 Procedures 

4.5.1 Exporting from Revit to Create/Update a New/Existing SAFE Model 

IMPORTANT NOTE: CSiXRevit only exports the analytical models of Revit elements. All the 
analytical models of all Revit elements must be correctly connected to others to ensure the stability 
of the SAFE model generated. Walls, columns, beams, and floors of a material type other than 
concrete are not imported in SAFE, and neither are columns with a section other than circular or 
rectangular, and beams with a section other than rectangular. 

The following steps describe how to send your Revit analytical model to SAFE: 

• To create a new SAFE model, from the Revit menu select, Tools>External Tools>Export to 
Create New ETABS or SAP2000 Model. To update an existing SAFE model, from the Revit 
menu, select Tools>External Tools>Export to Update Existing ETABS or SAFE Model. 

CSiXRevit counts the elements in the Revit project and displays the Export to Create New 
ETABS, SAP2000, or SAFE Model form, or Export to Update Existing Model form as may 
be the case: 

 

• Select the categories of Revit elements to export to SAFE. If you have selected some elements 
prior to starting the command and wish to only export those elements, check the corresponding 
box at the bottom of the form. 

SAFE analyzes horizontal single level structures but you do not need to select Revit elements 
from a single level. You will choose a level to import in the next step. 
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• Once you have made your selections, click OK.  

The Exporting to Create New ETABS SAP 2000 or SAFE Model or Exporting to Update 
Existing ETABS or SAFE model information message box is shown and displays the progress 
of the export: 

 

• Once the process has run its course, click OK. You are now asked to select a destination folder 
and filename. The file will be given the extension .exr.  

You are now ready to import the .exr file in ETABS: 

• Start SAFE if it is not already running.  

• To create a new SAFE model from your Revit project, you should not have any other model 
open. By default SAFE creates a new model based on your .EXR file. 

• To update an existing SAFE model, open it. 

• From the menu, select File>Import>EXR Revit file, and then select the .exr file to import. The 
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Import .EXR File form is displayed: 

 

• The form displays the contents of the exr file. Again, you can choose which categories of 
Revit elements to import or update. If the Revit project has multiple stories you can choose a 
story to import – or all of them in the case the structure is essentially plane and the story 
distinctions are not relevant. You can also specify a model Z offset so that the imported floor 
slabs and beams will be at the zero elevation - making it easier to work with in SAFE. 

• Click OK. The SAFE model is created. 
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4.5.2 Exporting from SAFE to Create/Update a New/Existing Revit Project 

The following steps describe how to export your SAFE model to create or update a Revit project: 

• Once you have edited, analyzed and designed your structure in SAFE, save the SAFE file by 
selecting the File>Save. 

• In SAFE, select File>Export Model>EXR File and specify a destination folder and filename 
in the form which is displayed. 

• The Export .EXR file form is displayed. It shows a count of the SAFE objects available for 
export. If the model was previously imported from Revit with a model offset other than zero, 
the opposite Project Z Offset is set by default. If you have selected parts of the model, and 
would like to send only those selections, check the Selected Objects Only box. 

 

You are now ready to import the .exr file in Revit. You import an .exr file written by SAFE exactly 
like an .exr file written by ETABS, as explained in Importing from ETABS to Create/Update a 
New/Existing Revit Project. 

4.5.3 Known Limitations of CSiXRevit with SAFE 

• Revit floors that are grouped together may be classified as openings when imported in SAFE. 

• Materials imported into Revit from SAFE may not always be properly mapped or the property 
values may not always be properly transferred. For this reason, material mapping and material 
property values should always be carefully checked in Revit after importing from SAFE. 
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